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Note to users in the United States of America

Notice:
This equipment has been tested and found to comply with the limits for a Class B digital device, pursu-
ant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference in a residential installation. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equip-
ment does cause harmful interference to radio or television reception, which can be determined by turn-
ing the equipment off and on, the user is encouraged to try to correct the interference by one more of
the following measures:

Reorient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.
Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.
Consult the dealer or an experienced radio/TV technician for help.

Caution
Changes or modifications not expressly approved by the party responsible for compliance could void
the user's authority to operate the equipment.

Caution (in case of IEEE1284 environment) :
Properly shielded and grounded cables and connectors must be used for connections to host computer
(and/or peripheral) in order to meet FCC emission limits.
Use a commercially available shielded cable.

Caution (in case of 100BaseTX environment):
Network interface cable with ferrite core must be used for RF interference suppression.
Use a commercially available cable after attaching the ferrite core provided.

Caution (in case of IEEE1394 environment):
Use the cable provided with the machine.

Caution (in case of USB2.0 environment):
Use a commercially available shielded USB cable.

Declaration of Conformity
Product Name:
Printer/Scanner Controller
Printer/Scanner Controller + Copy Machine
Model Number: 
Printer/Scanner Unit Type 2075 (Printer/Scanner Controller)
4051SP/DSm651SP/LD151SP/Aficio2051SP (Printer/Scanner Controller + Copy Machine)
4060SP/DSm660SP/LD160SP/Aficio2060SP (Printer/Scanner Controller + Copy Machine)
4075SP/DSm675SP/LD175SP/Aficio2075SP (Printer/Scanner Controller + Copy Machine)
Responsible party: Ricoh Corporation
Address: 5 Dedrick Place, West Caldwell, NJ 07006
Telephone number: 973-882-2000
This device complies with part 15 of FCC Rules.
Operation is subject to the following two conditions:
1. This device may not cause harmful interference, and
2. this device must accept any interference received,
including interference that may cause undesired operation.

Note to users in Canada

Note:
This Class B digital apparatus complies with Canadian ICES-003.

Remarque concernant les utilisateurs au Canada

Avertissement:
Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.

Introduction

This manual contains detailed instructions and notes on the operation and use of this machine. For your
safety and benefit, read this manual carefully before using the machine. Keep this manual in a handy
place for quick reference.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be li-
able for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.

Warning

Use of controls or adjustment or performance of procedures other than those specified in this manual
might result in hazardous radiation exposure.

Two kinds of size notation are employed in this manual. With this machine refer to the inch version.

Trademarks

Microsoft®, Windows® and Windows NT® are registered trademarks of Microsoft Corporation in the
United States and/or other countries.

Adobe®, PostScript®, Acrobat®, PageMaker® and Adobe Type Manager are registered trademarks of
Adobe Systems Incorporated.

PCL® is a registered trademark of Hewlett-Packard Company.

AppleTalk, Apple, Macintosh and Mac are registered trademarks of Apple Computer, Incorporated.

IPS-PRINT™ Printer Language Emulation Copyright© 2000, Oak Technology, Inc., All Rights Re-
served.

UNIX is a registered trademark in the United States and other countries, licensed exclusively through
X/Open Company Limited.

Bluetooth is a Trademark of the Bluetooth SIG, Inc. (Special Interest Group) and licensed to RICOH
company limited.

Copyright © 2001 Bluetooth SIG, Inc.

The Bluetooth Trademarks are owned by Bluetooth SIG, Inc. USA

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights to those marks.

The proper names of the Windows operating systems are as follows:

• The product name of Windows® 95 is Microsoft® Windows® 95

• The product name of Windows® 98 is Microsoft® Windows® 98

• The product name of Windows® Me is Microsoft® Windows®  Millennium Edition (Windows Me)

• The product name of Windows® 2000 are as follows:
Microsoft® Windows® 2000 Professional
Microsoft® Windows® 2000 Server
Microsoft® Windows® 2000 Advanced Server

• The product name of Windows® XP are as follows:
Microsoft® Windows® XP Home Edition
Microsoft® Windows® XP Professional

• The product names of Windows Server™ 2003 are as follows:
Microsoft® Windows Server™ 2003 Standard Edition
Microsoft® Windows Server™ 2003 Enterprise Edition

• The product name of Windows NT® 4.0 are as follows:
Microsoft® Windows NT® Workstation 4.0
Microsoft® Windows NT® Server 4.0

Notes

Some illustrations in this manual might be slightly different from the machine.

Certain options might not be available in some countries. For details, please contact your local dealer. Copyright © 2004
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Manuals for This Machine

The following manuals describe the operational procedures of this machine. For
particular functions, see the relevant parts of the manual.

Note
❒ Manuals provided are specific to machine type.
❒ Adobe Acrobat Reader is necessary to view the manuals as a PDF file.
❒ Two CD-ROMs are provided:

• CD-ROM 1“Operating Instructions for Printer/Scanner”
• CD-ROM 2“Scanner Driver & Document Management Utility”

❖❖❖❖ General Settings Guide
Provides an overview of the machine.
It also describes System Settings(such as paper trays and user codes settings),
Document Server functions, and troubleshooting.

❖❖❖❖ Network Guide (PDF file - CD-ROM1)
Provides information about configuring and operating the printer in a net-
work environment or using software. This manual covers all models, and
therefore contains functions and settings that may not be available for your
model. Images, illustrations, functions, and supported operating systems
may differ from those of your model. 

❖❖❖❖ Security Reference
This manual is for administrators of this machine. It describes security func-
tions that the administrators can use to protect data from being tampered, or
prevent the machine from unauthorized use. Also refer to this manual for the
procedures for registering administrators, as well as setting user and admin-
istrator authentication.

❖❖❖❖ Copy Reference
Describes operations, functions, and troubleshooting for the machine’s copier
function.

❖❖❖❖ Printer Reference (this manual)
Describes system settings, operations, functions, and troubleshooting for the
machine’s printer function.

❖❖❖❖ Scanner Reference (PDF file - CD-ROM1) 
Describes operations, functions, and troubleshooting for the machine’s scan-
ner function.
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❖❖❖❖ Manuals for DeskTopBinder Lite
DeskTopBinder Lite is a utility included on the CD-ROM labeled “Scanner
Driver & Document Management Utility”.
• DeskTopBinder Lite Setup Guide (PDF file - CD-ROM2) 

Describes installation of, and the operating environment for DeskTop-
Binder Lite in detail. This guide can be displayed from the [Setup] dialog
box when DeskTopBinder Lite is installed.

• DeskTopBinder Introduction Guide (PDF file - CD-ROM2)
Describes operations of DeskTopBinder Lite and provides an overview of
its functions. This guide is added to the [Start] menu when DeskTopBinder
Lite is installed.

• Auto Document Link Guide (PDF file - CD-ROM2) 
Describes operations and functions of Auto Document Link installed with
DeskTopBinder Lite. This guide is added to the [Start] menu when Desk-
TopBinder Lite is installed.

❖❖❖❖ Other manuals
• PS3 Supplement (PDF file - CD-ROM1)
• UNIX Supplement (available from an authorized dealer, or as a PDF file on

our Web site)
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How to Read This Manual

Symbols

In this manual, the following symbols are used:

R WARNING:
This symbol indicates a potentially hazardous situation which, if instructions
are not followed, could result in death or serious injury.

R CAUTION:
This symbol indicates a potentially hazardous situation which, if instructions
are not followed, may result in minor or moderate injury, or damage to proper-
ty.
* The statements above are notes for your safety.

Important
If this instruction is not followed, paper might misfeed, originals might be dam-
aged, or data might be lost. Be sure to read this.

Preparation
This symbol indicates prior knowledge or preparation is required before opera-
tion.

Note
This symbol indicates precautions for operation, or actions to take after mal-op-
eration.

Limitation
This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

Reference
This symbol indicates a reference.

[ ]
Keys and buttons that appear on the computer's display.
Keys that appear on the machine's display panel.

{ }
Keys built into the machine's control panel.
Keys on the computer's keyboard.
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1. Getting Started

Control Panel

1. Indicators
Displays errors and machine status.
m: Data In indicator
The Data In indicator shows the status of
data reception from a computer.

• This indicator blinks when data is be-
ing received.

• This indicator lights when there is
data remaining to be printed.

L: Service call indicator
x: Misfeed indicator
M: Open Cover indicator
d: Add Staple indicator
D: Add Toner indicator
See "Control Panel", General Settings
Guide.

2. {{{{User Tools/Counter/Inquiry}}}} key
• User Tools

Press to change default settings and
conditions to your requirements.

• Counter
Press to display or print the total
number of copies made.

• Inquiry
Press to check where to contact to
have the machine repaired or to order
toner.

3. {{{{Job List}}}} key
Show the job list. See "Job List", General
Settings Guide.

4. Display panel
Displays operation status, error messag-
es, and function menus. See p.6 “Display
Panel”.

5. {{{{Energy Saver}}}} key
Press to switch to and from Energy Saver
mode.

Note
❒ This key is ineffective during System

Settings (User Tools) operations.

6. Main power indicator 
This indicator lights when the main pow-
er switch is turned on.

Important
❒ Do not turn off the main power

switch while the Power indicator is
lit or blinking. Doing so may dam-
age the hard disk.

7. Power indicator
This indicator lights when the operation
switch is turned on.

AEW013S
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8. Operation switch
Press this switch to turn the power on
(the Power indicator goes on). To turn the
power off, press this switch again (the
Power indicator goes off).

9. {{{{Clear/Stop}}}} key
Press to cancel the entered data.

10. {{{{#}}}} key
Press after entering a value.

11. Number keys
Press to enter a value for various settings.

12. Function keys
Press to switch between the “Copy”,
“Document Server”, “Printer”, and
“Scanner” screens.
The indicator for the selected function
lights.

13. Function status indicators
These show the status of the above func-
tions:

• Yellow: the function is selected.
• Green: the function is active.
• Red: the function has been interrupted.

Display Panel

This section describes configuration using the display panel when the printer
function is selected.

Important
❒ The machine switches to offline when you make settings when the machine

is online. After you complete the setting, the machine switches to online au-
tomatically. 

❒ If you make a setting when the machine is offline, it will stay offline afterward.
❒ The function items displayed serve as selector keys. You can select or specify

an item by pressing it lightly.
❒ When you select or specify an item on the display panel, it becomes highlighted.
❒ Keys dimmed (for example, ) cannot be used.

1. Operational status or messages
Displays current machine status, such as
"Ready", "Offline", and "Printing...". In-
formation about the print job (user ID
and document name) appears in this sec-
tion.

2. [ffff Online] key/[ Offline] key
When you press these keys, the machine
switches between online and offline.
When the machine is online, it can re-
ceive data from the computer.
When the machine is offline, it cannot re-
ceive data from the computer.

OK

AEW016S

1

2
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3. [Form Feed] key
Press to print all the data left in the ma-
chine's input buffer.

Note
❒ When the machine is online, the status

appears dimly.
❒ This function is not available with the

RPCS printer language.

4. [Job Reset] key
Press to cancel the current print job.
If you press it when the machine is offline
and Hex Dump is selected, Hex Dump is
canceled. See p.114 “Printer Features Pa-
rameters”.

5. [Locked & Sample Print Job List]
Press to display Locked/Sample Print
jobs sent from a computer.

6. [Error Log]
Press  to  d isplay  the error  logs of
Locked/Sample Print jobs sent from a
computer.

7. [Spooling Job List]
Press to display spooled jobs.

8. [> Paper Tray Status] key
The paper tray settings appear.

Note
❒ When the power is turned on, the copier display is shown. This is a factory

default. This initial setting can be changed. See “User Tools (System Set-
tings)”, General Settings Guide.

❒ If the machine cannot be switched offline, select [Printer] for [Print Priority] on
[General Features] in the System Settings. For details about the setting, see “Us-
er Tools (System Settings)”, General Settings Guide.
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User Authentication

When user authentication (User Code
Authentication, Basic Authentication,
Windows Authentication, or LDAP
Authentication) is set, the authentica-
tion screen is displayed. Unless a valid
user name and password are entered,
operations are not possible with the
machine. Log on to operate the ma-
chine, and log off when you are fin-
ished operations. Be sure to log off to
prevent unauthorized users from us-
ing the machine.

Note
❒ Consult the User Administrator

about your login user name, pass-
word, and user code. For details
about the various types of user au-
thentication, consult the appropri-
ate administrators. 

❒ For user code authentication, enter
a number that is registered in the
Address Book as a login user name
as the user code.

User Code Authentication 
(Using the Control Panel)

When user authentication is set, the
following screen appears.

Enter a user code (eight digit), and
then press [#].

User Code Authentication 
(Using a Printer Driver)

When user authentication is set, spec-
ify the user code in the printer prop-
erties of a printer driver. For details,
see the printer driver Help.

Login (Using the Control 
Panel)

Follow the procedure below to log in
when Basic Authentication, Windows
Authentication, or LDAP Authentica-
tion is set.

AAAA Press [Enter] for [Login User Name].

BBBB Enter a login user name, and then
press [OK].

CCCC Press [Enter] for [Login Password].

DDDD Enter a login password, and then
press [OK].

EEEE Press [Login].
When the user is authenticated, the
screen for the function you are us-
ing appears.
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Logoff (Using the Control 
Panel)

Follow the procedure below to log off
when Basic Authentication, Windows
Authentication, or LDAP Authentica-
tion is set.

AAAA Press {{{{User Tools/Counter/Inquiry}}}}
key.

BBBB Press [→→→→ Logout].

CCCC Press [Yes].

DDDD Press {{{{User Tools/Counter/Inquiry}}}}
key.

Login (Using a Printer Driver)

When Basic Authentication, Windows
Authentication, or LDAP Authentica-
tion is set, make encryption settings in
the printer properties of a printer driv-
er, and then specify a login user name
and password. For details, see the
printer driver Help.

Note
❒ When logged on using a printer

driver, logging off is not required.

Login (Using Web Image 
Monitor)

Follow the procedure below to log on
when user authentication is set.

AAAA Click [Login].

BBBB Enter a login user name and pass-
word, and then click [OK].

Note
❒ For user code authentication,

enter a user code in [User Name],
and then click [OK].

❒ The procedure may differ de-
pending on the Web browser
used.

Log Off (Using Web Image 
Monitor)

Click [Logout] to log off.
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Connecting the Machine

Reference
For information about connection
using Ethernet and wireless LAN,
see "Confirming the Connection",
Network Guide.
For information about connection
using BluetoothTM, see the manual
that comes with the optional Blue-
tooth interface unit.

Requirements

Before using this machine, make sure
all environmental and electrical re-
quirements are met. Connect the ma-
chine to the host computer using the
parallel port, network interface unit,
or both.
Make sure all cables, connectors, and
electrical outlets necessary to attach
the machine to the host computer or
network are at hand.

Connecting the Machine to the 
host using the parallel 
cable/IEEE 1394 (SCSI print) 
cable

Connect the machine to the host com-
puter using the parallel port or op-
tional IEEE 1394 interface board. This
machine does not come with a paral-
lel cable to connect the machine to the
host computer.
The machine's parallel interface is a
standard bidirectional interface. It re-
quires a standard IEEE 1284 compli-
ant 36-pin parallel cable and a parallel
port on the host computer. Make sure
you purchase the appropriate cable
for the machine and your computer.

Note
❒ Do not use a parallel cable that is

longer than 3 meters (10 feet).
❒ Rating voltage of the interface con-

nector: Max. DC 5V
Follow the procedure below to con-
nect the machine to the host computer
using a parallel cable or IEEE 1394 in-
terface cable.

Important
❒ Before connecting the machine and

a computer using an interface ca-
ble, make sure the machine is not
operating, and then turn off the
main power switches of the ma-
chine and computer.

❒ Be sure to use a specified interface
cable. Other cables may cause ra-
dio interference.

AAAA If you use the parallel port, pro-
ceed to step BBBB. If you use IEEE
1394 interface, proceed to step FFFF.

BBBB Clip the ferrite core around the
printer end of the cable, close to
the connector.

Note
❒ The ferrite core (1 Piece) and tie

wraps (2 pieces) for the Ethernet
cable is supplied with this ma-
chine.

AEW022S
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CCCC Fit one tie wrap snugly around
the center of the ferrite core to
prevent the core coming loose.

DDDD Fit the other tie wrap snugly
around the end of the ferrite core
to prevent the core moving along
the cable.

EEEE Cut off excess tie wrap using scis-
sors.

FFFF Turn off the main power switches
of the machine and computer.

Important
❒ Before turning off the main pow-

er switch, see “Turning Off the
Power”, General Settings Guide.

GGGG Plug the cable into the connector
on the machine’s interface.

❖❖❖❖ Parallel Connection

❖❖❖❖ IEEE 1394 (SCSI print) Connection

HHHH Plug the other end of the cable
into the connector on the compu-
ter’s interface.

IIII Turn on the machine's main pow-
er switch.

JJJJ Turn on the computer.

AEW023S

AEW020S

ACA021S1

ACA022S1
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Note
❒ When using Windows 95/98/Me

/2000/XP and Windows Server
2003, a printer driver installation
screen might appear when the
computer is turned on. If this
happens, click [Cancel] on the
screen. For more information,
see p.19 “Preparing the Ma-
chine”.

The machine and computer are
now connected. The printer driver
must be installed next. For infor-
mation about how to install the
printer driver, see p.19 “Preparing
the Machine”.

Connecting the machine to the 
host using a USB cable

You can connect the machine to the
host computer using a USB interface
cable when the optional USB 2.0 inter-
face board is installed in the machine.
This machine does not come with a
USB interface cable. Make sure you
purchase the appropriate cable for the
machine and your computer.
Follow the procedure below to con-
nect the machine to the host computer
using a USB interface cable.

AAAA Connect the USB 2.0 interface ca-
ble to the USB port on the right
side of the machine's back cover.

BBBB Connect the other end to the USB
port on the host computer.

Note
❒ The optional USB 2.0 interface

board is supported by Windows
98 SE/Me/2000/XP, Windows
Server 2003, Mac OS 9.x, and
Mac OS X Classic mode.
• For Windows 98 SE/Me:

Make sure to install “USB
Printing Support”. If USB 2.0
is used with Windows 98
SE/Me, only a speed equal to
that of USB 1.1 is possible.

• For Mac OS:
Mac OS supports only the
standard USB port. If USB 2.0
is used with a Mac OS, only a
speed equal to that of USB 1.1
is possible.

ACA019S1
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Connecting to the Ethernet 
Interface

The network interface board supports
10BASE-T or 100BASE-TX connec-
tions.

Important
❒ Before making the connection,

touch the metallic part to ground
yourself.

AAAA A core for the Ethernet cable is
supplied with this  machine.
Make a loop at the end of the Eth-
ernet cable, and then attach the
core as shown below.

BBBB Turn off the main power switch.

Important
❒ Make sure the main power is

off. See "Turning On the Pow-
er", General Settings Guide.

CCCC Connect the Ethernet interface ca-
ble to the 10BASE-T/100BASE-TX
port.

DDDD Turn on the main power switch.

1. Indicator (green)
Remains green when the machine is
properly connected to the network.

2. Indicator (yellow)
Turns yellow when 100 BASE-TX is
operating. Turns off when 10 BASE-T
is operating.

AEW017S

AEW012S

ZKRH050E
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Setting Paper on the Bypass Tray

This section gives instructions for set-
ting paper on the bypass tray. Use the
bypass tray to print onto OHP trans-
parencies, labels, thick paper, and en-
velopes that cannot be loaded in the
paper tray.

Reference
For details about setting paper in
the regular paper tray, see General
Settings Guide.

Note
❒ When loading letterhead paper,

pay attention to its orientation. See
“Orientation-Fixed Paper or Two-
Sided Paper”, General Settings
Guide.

❒ Paper within the following dimen-
sions can be set in the bypass tray: 
• Vertical: 100.0-305.0 mm (3.94

in. - 12.01 in.)
• Horizontal: 139.7-600.0 mm (5.50

in. - 23.62 in.)
❒ Be sure to set the paper with the

side you want to print facing down
in the bypass tray.

❒ When loading OHP transparencies
or thick paper in the bypass tray,
make the paper setting using the
control panel or printer driver. 

❒ The number of sheets that can be
loaded in the bypass tray depends
on the paper type.

❒ Paper sizes fed from the bypass
tray are output first sheet down,
print side-up.

Limitation
❒ The following functions are disa-

bled when printing from the by-
pass tray: 
• Duplex printing
• Auto Tray Select
• Auto Tray Switching
• Rotating Collate
• Staple (when the optional unit is

installed)
• Punch (when the optional unit

is installed)
• Z-fold (when the optional unit

is installed)

Important
❒ When printing using the printer

function, original images are always
rotated by 180 degrees (the orienta-
tion of images to be printed is oppo-
site to that of the copier function).
When printing onto paper with spe-
cific orientation requirements, such
as envelopes and letterheads, make
sure to rotate the paper feed orienta-
tion to 180 degrees.

❒ Be sure to set the paper size using
the printer driver when printing
data from the computer. The paper
size set using the printer driver has
priority over the one set using the
display panel.
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AAAA Open the bypass tray.

BBBB Adjust the paper guides to the pa-
per size.

Important
❒ If the paper guides are not flush

against the paper, skewed im-
ages or paper misfeeds might
occur.

CCCC Gently insert paper face up into
the bypass tray until the beeper
sounds.

1. Extender

2. Paper guides

Note
❒ The beeper will not sound if it is

turned off. Gently insert paper
until it stops.

❒ Do not stack paper over the lim-
it mark, otherwise a skewed im-
age or misfeeds might occur.

❒ Open out the extender to sup-
port paper sizes larger than A4
L, 81/2"×11" L.

❒ Fan the paper to get air between
the sheets to avoid a multi-sheet
feed.

❒ When setting an OHP transpar-
ency, make sure that its front
and back sides are properly po-
sitioned.

❒ Select paper type when printing
onto OHP transparencies or
thick paper (over 105 g/m2). For
details, see p.17 “Setting thick
paper or OHP transparencies”.

DDDD Select the paper size.

Note
❒ You can set paper size using the

printer driver. The following
procedures are not necessary
when setting paper size using
the printer driver.

❒ The paper size set using the
printer driver has priority over
that set using the display panel.

❒ When the printer driver is not
used, make settings using the
display panel.

❒ Thick paper and OHP transpar-
encies are delivered face up on
the top of the preceding page;
therefore, the prints need to be
rearranged into the correct or-
der. To avoid this, select [Reverse
order print] in the RPCS printer
driver settings to deliver the
prints in the correct page order.

Reference
For printer driver settings, see
the printer driver Help.
For details about setting custom
sizes, see p.16 “Setting custom
size paper”.

AEW003S

2 1
AEW004S
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A Press the {{{{User Tools/Counter}}}}
key on the control panel.

B Press [System Settings].

C Press the [Tray Paper Settings]
tab.

D Press [TTTTNext] to scroll through
the list.

E Press [Printer Bypass Paper Size].

F Select the paper size.

Note
❒ Press [UUUUPrevious] or [TTTTNext]

to scroll through the list.
❒ When printing onto thick pa-

per or OHP transparencies,
select paper type. For details,
see p.17 “Setting thick paper
or OHP transparencies”.

G Press [OK].
H Press the {{{{User Tools/Counter}}}}

key.

Setting custom size paper

Note
❒ Custom sizes can also be set using

the printer driver. The following
procedures are not necessary
when setting custom sizes using
the printer driver.

❒ Custom size settings set using the
printer driver have priority over
those set using the machine's dis-
play panel.

❒ When the printer driver is not
used, make settings using the dis-
play panel.

Reference
For printer driver settings, see the
printer driver Help.

AAAA Press the {{{{User Tools/Counter}}}} key
on the control panel.

BBBB Press [System Settings].

CCCC Press the [Tray Paper Settings] tab.

DDDD Press [TTTTNext] to scroll through the
list.

EEEE Press [Printer Bypass Paper Size].

FFFF Press [Custom Size].

If a custom size is already set, press
[Change Size] .

GGGG Press [Vertical].

HHHH Enter the vertical size of the paper
using the number keys, and then
press [#].

AEW014S
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IIII Press [←←←←> Horizontal].

JJJJ Enter the horizontal size of the
paper using the number keys, and
then press [#].

KKKK Press [OK].

The paper sizes entered are dis-
played.

LLLL Press [OK].

MMMM Press the {{{{User Tools/Counter}}}} key.

Setting thick paper or OHP 
transparencies

Note
❒ Paper settings can also be set using

the printer driver. The following
procedures are not necessary
when setting paper sizes using the
printer driver.

❒ Paper size settings set using the
printer driver have priority over
those set using the machine's dis-
play panel.

❒ When the printer driver is not
used, make settings using the dis-
play panel.

Reference
For printer driver settings, see the
printer driver Help.

AAAA Press the {{{{User Tools/Counter}}}} key
on the control panel.

BBBB Press [System Settings].

CCCC Press the [Tray Paper Settings] tab.

DDDD Press [TTTTNext] to scroll through the
list.

EEEE Press [Paper Type: Bypass Tray].

FFFF Select [OHP] or [Thick Paper]

GGGG Press [OK].

The paper type selected is dis-
played.

HHHH Press the {{{{User Tools/Counter}}}} key.

Note
❒ The settings made will remain

valid until they are reset again.
After printing on OHP trans-
parencies or thick paper, make
sure to clear settings for the next
user.
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2. Preparing the Machine

Quick Install

Windows 95/98/Me/2000/XP, Windows Server 2003, and Windows NT 4.0 us-
ers can easily install this software using the CD-ROM provided.
Using Quick Install, the PCL printer driver and/or RPCS printer driver and
SmartDeviceMonitor for Client is installed under network environment, and
TCP/IP port will be set.

Important
❒ To install printer driver under Windows 2000/XP Professional, Windows

Server 2003, and Windows NT 4.0, you must have an account that has Man-
age Printers permission. Log on as an Administrator.

❒ The Quick Install is not available when using this printer under USB connec-
tion. If you connect using USB, refer to p.43 “Installing the Printer Driver Us-
ing USB”. 

AAAA Quit all applications currently running.

BBBB Insert the CD-ROM into the CD-ROM drive.

The installer starts. 
Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

CCCC Select an interface language, and then click [OK].

The default interface language is English.

DDDD Click [Quick Install].

The software license agreement appears in the [License Agreement] dialog box.

EEEE After reading the agreement, click [I accept the agreement] , and then click
[Next >].

FFFF Select the machine model you want to use in the [Select Printer] dialog box.

For network connection via TCP/IP, select the machine whose IP address is
displayed in [Connect To].
For parallel connection, select the machine whose printer port is displayed in
[Connect To].

GGGG Click [Install].

The printer driver installation starts. 

HHHH Click [Finish] 

A message about restarting the computer may appear. Restart the computer
to complete installation.
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IIII Click [Exit] in the first dialog box of the installer, and then take out the CD-
ROM.

Note
❒ To stop installation of the selected software, click [Cancel] before installa-

tion is complete. Restart the computer, and then reinstall the other soft-
ware or printer drivers.

❒ Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

❒ Select a machine to whose IP address is displayed in [Connect To] to install
SmartDeviceMonitor for Client when using TCP/IP.

Reference
Quick Install is not available unless bidirectional communication between
the machine and computer is enabled via parallel connection. See p.61 “If
Bidirectional Communication is Disabled” for details about bidirectional
communication between machine and computer.
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Confirming the Connection Method

This machine supports network and local connection.
Before installing the printer driver, check how the machine is connected. Follow
the driver installation procedure that is appropriate to the connection method.

Network Connection

This machine can be used as a Windows printing port or network printer.

Using this machine as the Windows printing port

Network connections can be established through Ethernet, IEEE 802.11b, and
IEEE 1394 (IP over 1394).
Available ports are determined based on the combination of Windows operating
system version and connection method used.

❖❖❖❖ Windows 95/98

❖❖❖❖ Windows Me

Connection Method Available Ports

Ethernet/ IEEE 802.11b SmartDeviceMonitor for Client port

IEEE 1394 (IP over 1394) None

Connection Method Available Ports

Ethernet/ IEEE 802.11b SmartDeviceMonitor for Client port

IEEE 1394 (IP over 1394) SmartDeviceMonitor for Client port

Windows 95/98/Me Windows XP/
Server 2003

Windows NT 4.0Windows 2000

ZZZ004S

SmartDeviceMonitor for Client 

 -TCP/IP

 -NetBEUI

 -IPP

SmartDeviceMonitor for Client

 -TCP/IP

 -NetBEUI

 -IPP

Standard TCP/IP

LPR

SmartDeviceMonitor for Client

 -TCP/IP

 -IPP

Standard TCP/IP

LPR

SmartDeviceMonitor for Client

 -TCP/IP

 -NetBEUI

 -IPP

LPR
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❖❖❖❖ Windows 2000

❖❖❖❖ Windows XP

❖❖❖❖ Windows Server 2003

❖❖❖❖ Windows NT 4.0

Reference
See the explanation of how to install the printer driver for each type of port.
For the SmartDeviceMonitor for Client port, see p.25 “Using the SmartDe-
viceMonitor for Client Port”.
For the Standard TCP/IP port, see p.34 “Using the Standard TCP/IP Port”.
For the LPR port, see p.36 “Using the LPR Port”.

Connection Method Available Ports

Ethernet/ IEEE 802.11b SmartDeviceMonitor for Client port

Standard TCP/IP

LPR port

IEEE 1394 (IP over 1394) None

Connection Method Available Ports

Ethernet/ IEEE 802.11b SmartDeviceMonitor for Client port

Standard TCP/IP

LPR port

IEEE 1394 (IP over 1394) SmartDeviceMonitor for Client port

Standard TCP/IP

Connection Method Available Ports

Ethernet/ IEEE 802.11b SmartDeviceMonitor for Client port

Standard TCP/IP

LPR port

IEEE 1394 (IP over 1394) SmartDeviceMonitor for Client port

Standard TCP/IP

Connection Method Available Ports

Ethernet/ IEEE 802.11b SmartDeviceMonitor for Client port

LPR port

IEEE 1394 (IP over 1394) None
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Using as a network printer

This machine can be used as the Windows network printer, the NetWare print
server, or the NetWare remote printer.

Reference
See the explanation of how to install the printer driver for each type of net-
work printer. 
For the Windows network printer, see p.38 “Using as the Windows Network
Printer”.
For the NetWare print server and remote printer, see p.40 “Using as the Net-
Ware Print Server/Remote Printer”.

Local Connection

Local connections can be established via parallel, USB, IEEE 1394 (SCSI print),
and Bluetooth connections.
Windows operating system version determines the available connection meth-
ods.
• Windows 95:

• Parallel connections
• Windows 98: 

• Parallel and Bluetooth connections
• Windows 98 SE/Me:

•  USB, Parallel, and Bluetooth connections
• Windows 2000:

• USB, Parallel, IEEE 1394 (SCSI print), and Bluetooth connections

Windows 2000/XP
Windows Server 2003
Windows NT 4.0
Print Server

Windows 95/98/Me Windows 2000 Windows XP/
Server 2003

Windows NT 4.0

NetWare
Print Server

NetWare
File Server

ZZZ003S
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• Windows XP:
• USB, Parallel, IEEE 1394 (SCSI print), and Bluetooth connections

• Windows Server 2003:
• USB, Parallel, IEEE 1394 (SCSI print), and Bluetooth connections

• Windows NT 4.0:
• Parallel and Bluetooth connections

Reference
See the explanation of how to install the printer driver for each method of
connection. 
For the USB connection, see p.43 “Installing the Printer Driver Using USB”.
For the parallel connection, see p.49 “Printing with Parallel Connection”.
For the IEEE 1394 (SCSI print) connection, see p.51 “Installing the Printer
Driver Using IEEE 1394 (SCSI print)”.
For the Bluetooth connection, see p.55 “Printing with Bluetooth™ Connec-
tion”.
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Using the SmartDeviceMonitor for Client 
Port

Installing SmartDeviceMonitor for Client

Important
❒ To install SmartDeviceMonitor for Client under Windows 2000/XP Profes-

sional, Windows Server 2003, and Windows NT 4.0, you must have an ac-
count that has Manage Printers permission. Log on as an Administrator.

❒ Install SmartDeviceMonitor for Client before installing the printer driver
when using the SmartDeviceMonitor for Client port.

AAAA Quit all applications currently running.

BBBB Insert the CD-ROM into the CD-ROM drive.

The installer starts.
Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

CCCC Select an interface language, and then click [OK].
The default interface language is English.

DDDD Click [SmartDeviceMonitor for Client/Admin].

EEEE The SmartDeviceMonitor for Client installer starts.

FFFF The software license agreement appears in the [License Agreement] dialog
box. After reading through its contents, click [I accept the agreement], and
then click [Next >].

GGGG Click [SmartDeviceMonitor for Client], and then click [Next >].

The SmartDeviceMonitor for Client installer starts.

HHHH Follow the instructions on the display to install SmartDeviceMonitor for
Client. 

IIII Click [Finish].

If you are required to restart the computer after installing SmartDeviceMon-
itor for Client, restart the computer.

Note
❒ To stop installation of the selected software, click [Cancel] before installa-

tion is complete. Restart the computer and reinstall other programs or
printer drivers.
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Installing the PCL or RPCS Printer Driver (TCP/IP)

Important
❒ To install this printer driver under Windows 2000/XP Professional, Windows

Server 2003, and Windows NT 4.0, you must have an account that has Man-
age Printers permission. Log on as an Administrators or Power Users group
member.

AAAA Quit all applications currently running.

BBBB Insert the CD-ROM into the CD-ROM drive.

The installer starts.
Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

CCCC Select an interface language, and then click [OK].

The default interface language is English.

DDDD Click [PCL/RPCS Printer Drivers].

EEEE The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [I accept the agreement], and then click [Next].

FFFF Select the printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.

GGGG Select the machine model you want to use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

HHHH Double-click the printer name to display the printer settings.

Note
❒ The details shown in [Comment:], [Driver:], and [Port:] vary depending on

the operating system, printer model, and port.

IIII Click [Port:], and then click [Add].

JJJJ Click [SmartDeviceMonitor], and then click [New Port...].

KKKK Click [TCP/IP], and then click [Search].
A list of printers using TCP/IP appears.
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LLLL Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use
a machine not listed here, click [Specify Address], and then enter the IP address
or host name of the machine.
Under Windows 95/98/Me, you cannot add an IP address partially similar to
the one already used. For example, if “192.168.0.2” is in use, “192.168.0.2xx”
cannot be used. Similarly, if “192.168.0.20” is in use, “192.168.0.2” cannot be
used. 

MMMM Check that the port of the selected printer is displayed in [Port:].

NNNN Set a user code, if necessary. 
This allows a SmartDeviceMonitor for Admin user to display and check sta-
tistics about the number of sheets which each user prints. For details, see
SmartDeviceMonitor for Admin Help. 
Up to 8 numeric characters can be entered. Neither alphabetic characters nor
symbols are available.

OOOO Select the [Default Printer] check box to configure the printer as default.

PPPP Click [Finish].

Installation starts.

QQQQ Click [Finish] in the installation completion dialog box.

A message about restarting the computer may appear. Restart the computer
to complete installation

Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, install use [Add Printer]. See p.58
“If a Message Appears during Installation”.
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Installing the PCL or RPCS Printer Driver (NetBEUI)

Important
❒ To install this printer driver under Windows 2000, and Windows NT 4.0, you

must have an account that has Manage Printers permission. Log on as an Ad-
ministrators or Power Users group member.

❒ Windows XP and Windows Server 2003 do not support NetBEUI.
❒ You cannot print using printers beyond routers.

AAAA Quit all applications currently running.

BBBB Insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe”on the CD-ROM root directory.

CCCC Select an interface language, and then click [OK].

The default interface language is English.

DDDD Click [PCL/RPCS Printer Drivers].

EEEE The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [I accept the agreement] , and then click
[Next].

FFFF Select the printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.

GGGG Select the machine model you want to use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

HHHH Double-click the printer name to display the printer settings.

Note
❒ The details shown in [Comment:], [Driver:], and [Port:] vary depending on

the operating system, printer model, and port.

IIII Click [Port:], and then click [Add].

JJJJ Click [SmartDeviceMonitor], and then click [New Port...].

KKKK Click [NetBEUI], and then click [Search].

A list of printers using NetBEUI appears.
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LLLL Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use
a machine not listed here, click [Specify Address], and then enter the NetBEUI
address. The NetBEUI address can be checked with the configuration page.
For information about printing a configuration page, see p.114 “Printing the
configuration page”. The NetBEUI address appears in the format of
“\\RNPxxxx\xxx” on the configuration page. Enter the machine's network
path in the format of “%%Computer name\Share name”. Use “\\” instead of
“%%” at the beginning.

MMMM Check that the port of the selected printer is displayed in [Port:].

NNNN Set a user code, if necessary. 

This allows a SmartDeviceMonitor for Admin user to display and check sta-
tistics about the number of sheets which each user prints. For details, see
SmartDeviceMonitor for Admin Help.
Up to 8 numeric characters can be entered. Neither alphabetic characters nor
symbols are available.

OOOO Select the [Default Printer] check box to configure the printer as default.

PPPP Click [Finish].
The printer driver installation starts.

QQQQ Click [Finish] in the installation completion dialog box.

A message about restarting the computer may appear. Restart the computer
to complete installation.

Note
❒ The protocol is set to inactive as default. Enable it using Web Image Mon-

itor or Telnet.
❒ To stop installation of the selected software, click [Cancel] before installa-

tion is complete. Restart the computer and reinstall other software pro-
grams or printer drivers.

Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See p.58 “If a
Message Appears during Installation”.
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Installing the PCL or RPCS Printer Driver (IPP)

Important
❒ To install printer driver under Windows 2000/XP Professional, Windows

Server 2003, and Windows NT 4.0, you must have an account that has Man-
age Printers permission. For this, log on as an Administrators or Power Users
group member.

AAAA Quit all applications currently running.

BBBB Insert the CD-ROM into the CD-ROM drive.

The installer starts.
Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

CCCC Select an interface language, and then click [OK].

The default interface language is English.

DDDD Click [PCL/RPCS Printer Drivers].

EEEE The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [I accept the agreement] , and then click
[Next].

FFFF Select a printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.

GGGG Select the machine model you want to use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

HHHH Double-click the printer name to display the printer settings.

Note
❒ The details shown in [Comment:], [Driver:], and [Port:] vary depending on

the operating system, printer model, and port.

IIII Click [Port:], and then click [Add].

JJJJ Click [SmartDeviceMonitor], and then click [New Port...].

KKKK Click [IPP].
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LLLL In the [Printer URL] box, enter “http://printer's address/printer” as the print-
er's address.
If the server authentification is issued, to enable SSL (a protocol for encrypted
communication), enter “https://printer's address/printer” (Internet Explor-
er 5.01, or a higher version must be installed).
(example IP address: 192.168.15.16)
http://192.168.15.16/printer
https://192.168.15.16/printer

You can enter "http://printer's address/ipp" as the printer's address.

MMMM Enter a name for identifying the printer in [IPP Port Name]. Use a name dif-
ferent from the one of any existing port.

If a name is not specified here, the address entered in the [Printer URL] box be-
comes the IPP port name.

NNNN Click [Detailed Settings] to make necessary settings.
For information about the settings, see SmartDeviceMonitor for Client Help.

OOOO Check that the port of the selected printer is displayed in [Port:].

PPPP Set a user code, if necessary. 

This allows a SmartDeviceMonitor for Admin user to display and check the
number of sheets each user prints. For details, see SmartDeviceMonitor for
Admin Help.
Up to 8 numeric characters can be entered. No alphabetic characters or sym-
bols can be entered.

QQQQ Select the [Default Printer] check box to configure the printer as default.

RRRR Click [Finish].

Installation starts.

SSSS Click [Finish] in the installation completion dialog box.

A message about restarting the computer may appear. Restart the computer
to complete installation

Note
❒ To stop installation of the selected software, click [Cancel] before installa-

tion is complete. Restart the computer and reinstall other software pro-
grams or printer drivers.

Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use[Add Printer]. See p.58 “If a
Message Appears during Installation”.
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Changing the Port Settings for SmartDeviceMonitor for Client

Follow the procedure below to change the SmartDeviceMonitor for Client set-
tings, such as TCP/IP timeout, recovery/parallel printing, and printer groups.

Note
❒ There are no settings for NetBEUI protocol.

Windows 95/98:

AAAA Open [Printers] window from [Start] menu. .

BBBB  In the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties] 

CCCC  Click the [Details] tab, and then click [Configure Port].

The [Port Settings] dialog box appears.

Windows 2000 / Windows NT 4.0:

AAAA Open [Printers] window from [Start] menu. .

BBBB In the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties] 

CCCC On the [Ports] tab, click [Configure Port] 
The [Port Settings] dialog box appears.

Windows XP, Windows Server 2003: 

AAAA Open the [Printers and Faxes] window from the [Start] menu.

The [Printers and Faxes] window appears.

BBBB Click the icon of the machine you want to use. On the [File] menu, click
[Properties]. The printer properties appear.

CCCC  Click the [Ports] tab, and then click [Configure Port].

The [Port Configuration] dialog box appears.
• For TCP/IP, timeout setting can be configured.
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Note
❒ If no settings on the [Recovery/Parallel Printing] tab are available, follow

the procedure below.
A Click [Cancel] to close the [Port Configuration:] dialog box.
B Start SmartDeviceMonitor for Client, and then right-click the Smart-

DeviceMonitor for Client icon on the taskbar.
C Click [Extended Features Settings], and then select the [Set Recovery/Par-

allel Printing for each port] check box.
D Click [OK] to close the [Extended Features Settings] dialog box

• User, proxy, and timeout settings can be configured for IPP.

Reference
For information about these settings, see "Using SmartDeviceMonitor for
Client", Network Guide, or SmartDeviceMonitor for Client Help.

MartiniC25-EN-Pref-F5_FM.book  Page 33  Thursday, December 9, 2004  10:59 AM



Preparing the Machine

34

2

Using the Standard TCP/IP Port

Installing the PCL or RPCS Printer Driver

Important
❒ To install printer driver under Windows 2000/XP Professional, and Win-

dows Server 2003, you must have an account that has Manage Printers per-
mission. Log on as an Administrators or Power Users group member.

AAAA Quit all applications currently running.

BBBB Insert the CD-ROM into the CD-ROM drive.

The installer starts.
Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

CCCC Select an interface language, and then click [OK].
The default interface language is English.

DDDD Click [PCL/RPCS Printer Drivers].

EEEE The software license agreement appears in the [License Agreement] dialog
box.
After reading the agreement, click [I accept the agreement], and then click [Next].

FFFF Select a printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

GGGG Select the machine model you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

HHHH Double-click the printer name to display the printer settings.

Note
❒ The details shown in [Comment:], [Driver:], and [Port:] vary depending on

the operating system, printer model, and port.

IIII Click [Port:], and then click [Add].

JJJJ Click [Standard TCP/IP], and then click [New Port...].
Configure the Standard TCP/IP port settings, and then see Windows Help if
[Standard TCP/IP Port] does not appear.

KKKK Click [Next] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.
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LLLL Enter the printer name or IP address in the [Printer Name or IP Address] box.

The [Port Name] text box automatically obtains a port name. Change this name
if necessary.
When screen for Device selection appears, select "RICOH NetworkPrinter
Driver C Model".

MMMM Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

The installation start dialog box reappears.

NNNN Check that the port of the selected printer is displayed in [Port:].

OOOO Configure the default printer as necessary.

PPPP Click [Finish].
The printer driver installation starts.

QQQQ Click [Finish] in the installation completion dialog box.
A message about restarting the computer may appear. Restart the computer
to complete installation.

Note
❒ To stop installation of the selected software, click [Cancel] before installa-

tion is complete. Restart the computer and reinstall other software pro-
grams or printer drivers.

Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See p.58 “If a
Message Appears during Installation”.
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Using the LPR Port

Installing the PCL or RPCS Printer Driver

Important
❒ To install this printer driver under Windows 2000/XP Professional, Windows

Server 2003, and Windows NT 4.0, you must have an account that has Man-
age Printers permission. Log on as an Administrators or Power Users group
member.

AAAA Quit all applications currently running.

BBBB Insert the CD-ROM into the CD-ROM drive.

The installer starts.
Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

CCCC Select an interface language, and then click [OK].

The default interface language is English.

DDDD Click [PCL/RPCS Printer Drivers].

EEEE The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [I accept the agreement], and then click [Next].

FFFF Select a printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.

GGGG Select the machine model you want to use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

HHHH Double-click the printer name to display the printer settings.

Note
❒ The details shown in [Comment:], [Driver:], and [Port:] vary depending on

the operating system, printer model, and port.

IIII Click [Port:], and then click [Add].

JJJJ Click [LPR Port], and then click [New Port...].

If [LPR Port] does not appear, see Windows Help and install it.

KKKK Enter the printer's IP address in the [Name or address of server providing lpd]
box.
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LLLL Enter “lp” in the [Name of printer or print queue on that server] box, and then click
[OK].
The port is added.

MMMM Check that the port of the selected printer is displayed in [Port:].

NNNN Configure the default printer as necessary.

OOOO Click [Finish].

The printer driver installation starts

PPPP Click [Finish] in the installation completion dialog box.

A message about restarting the computer may appear. Restart the computer
to complete installation. 

Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See p.58 “If a
Message Appears during Installation”.
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Using as the Windows Network Printer

Installing the PCL or RPCS Printer Driver

To use the print server, install the printer driver by selecting "Network printer
server", and then select the Windows 2000/XP, Windows Server 2003, or Win-
dows NT 4.0 shared printer.
This section assumes that the client has already been configured to communicate
with a Windows 2000/XP, Windows Server 2003, or Windows NT 4.0 print serv-
er. Do not begin the following procedure before the client is set up and config-
ured correctly.

Important
❒ To install printer driver under Windows 2000/XP Professional, Windows Serv-

er 2003, and Windows NT 4.0, you must have an account that has Manage
Printers permission. For this, log on as an Administrators or Power Users
group member.

❒ If you print with a print server connected to the printer using the SmartDe-
viceMonitor port, Recovery Printing and Parallel Printing cannot be used
from the client.

❒ If you print with a Windows XP or Windows Server 2003 print server, notifi-
cation functions of SmartDeviceMonitor may not be used with the client. 

❒ If you print with a Windows NT 4.0 print server, install the printer driver be-
fore you connect the print server to the printer.

AAAA Quit all applications currently running.

BBBB Insert the CD-ROM into the CD-ROM drive.

The installer starts.
Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

CCCC Select an interface language, and then click [OK].

The default interface language is English.

DDDD Click [PCL/RPCS Printer Drivers].

EEEE The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [I accept the agreement], and then click [Next].

FFFF Select a printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.
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GGGG Select the [Printer Name] check box to select the printer models you want to
use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

HHHH Double-click the printer name to display the printer settings.
The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

IIII Click [Port:], and then click [Add].

JJJJ Click [Network Printer], and then click [OK].

KKKK Double-click the computer name you want to use as a print server in the
[Browse for Printer] window.

LLLL Select the printer you want to use, and then click [OK].

MMMM Check that the port of the selected printer is displayed in [Port:].

NNNN Configure the user code as necessary.

For an RPCS printer driver, a user code can be set after the printer driver in-
stallation. For information about user code, see the printer driver Help.

OOOO Select the [Default Printer] check box to configure the printer as default.

PPPP Click [Finish].
The printer driver installation starts.

QQQQ Click [Finish] in the installation completion dialog box.
A message about restarting the computer may appear. Restart the computer
to complete installation. 

Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See p.58 “If a
Message Appears during Installation”.
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Using as the NetWare Print Server/Remote 
Printer

This explains how to set up the Windows computer used as the NetWare client.

Important
❒ To install this printer driver under Windows 2000/XP Professional, Windows

Server 2003, and Windows NT 4.0, you must have an account that has Man-
age Printers permission. Log on as an Administrators or Power Users group
member.

The following explanation assumes NetWare Client is installed on the client
computer and the NetWare server environment is correctly set up. Install all nec-
essary client applications before following this procedure.
Set up the printer driver while logging on to the NetWare file server.
The following values are used in the example:
• Operating system: Windows 98
• NetWare version: 4.1
• File server name: CAREE
• Queue name: R-QUEUE

AAAA Insert the CD-ROM into the CD-ROM drive.

The installer starts.
Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory

BBBB Select an interface language, and then click [OK].

The default interface language is English.

CCCC Click [PCL/RPCS Printer Drivers].

DDDD The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [I accept the agreement], and then click [Next].

EEEE Select the printer driver you want to use in the [Select Program] dialog box. 

You can select several printer drivers.

FFFF Select the [Printer Name] check box to select the printer models you want to
use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

GGGG Double-click the printer name to display the printer settings.

The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.
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HHHH Click [Port:], and then click [Add].

IIII Click [Network Printer], and then click [OK].

JJJJ Double-click the name of the NetWare file server on the network tree.

The created queue is displayed.

KKKK Select the print queue, and then click [OK].

LLLL Check that the port of the selected printer is displayed in [Port:].

MMMM Click [Finish].

The printer driver installation starts.

NNNN Click [Finish] in the [Component selection] dialog box.

OOOO Click [Finish] in the [Introduction complete] dialog box.

PPPP In the [Printers] window, open the printer properties.

Under Windows XP or Windows Server 2003, open the printer properties
from the [Printers and Faxes] window. 

QQQQ On the [Printer Settings] tab, clear the [Form Feed] and [Enable Banner] check
boxes.

Under Windows 2000/XP, Windows Server 2003, or Windows NT 4.0, click
the [NetWare setting] tab.
Do not select these check boxes since they are automatically selected by the
printer driver. If you select the check boxes, the printer may not print correct-
ly.

RRRR Click [OK] to close the printer properties dialog box.

Note
❒ The protocol is set to inactive as default. Enable it using Web Image Mon-

itor or Telnet

Form Feed

Do not use NetWare to configure form feed. Form feed is controlled by the print-
er driver on Windows. If NetWare form feed is configured, the printer may not
print properly. 
Follow the procedure below to disable form feed according to the operating sys-
tem used:
• Under Windows 95/98/Me, clear the [Form feed] check box on the [Printer Set-

tings] tab in the printer properties dialog box.
• Under Windows 2000/XP, Windows Server 2003, or Windows NT 4.0, clear

the [Form feed] check box on the [NetWare Settings] tab in the printer properties
dialog box.
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Banner Page

Do not use NetWare to configure a banner page. 
Follow the procedure below to disable banner pages according to the operating
system used:
• Under Windows 95/98/Me, clear the [Enable banner] check box on the [Printer

Settings] tab in the printer properties dialog box.
• Under Windows 2000/XP, Windows Server 2003, or Windows NT 4.0, clear

the [Enable banner] check box on the [NetWare Settings] tab in the printer prop-
erties dialog box.

Printing after Resetting the Printer

Printer to print server connection requires 30 - 40 seconds to resume after the
printer is reset. During this period, jobs may be accepted (depending on Net-
Ware specifications) but not printed.
To print after resetting the printer as the remote printer, check on the print server
that the remote printer is disconnected, or wait for two minutes before trying to
print.
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Installing the Printer Driver Using USB

This section explains how to install printer drivers using USB.

Important
❒ Make sure that machine is connected to the computer's USB ports using the

USB interface cable.
Before installing, check that only the operating system is running on the compu-
ter and no print jobs are in progress.
The printer drivers can be installed from the CD-ROM provided with this ma-
chine.

Windows 98 SE/Me - USB

Important
❒ Installation via USB is not possible under Windows 95/98. Upgrade to Win-

dows 98 SE/Me.
When USB is first used, the plug and play function starts and the [New Hardware
Found], [Device Driver Wizard], or [Add New Hardware Wizard] dialog box appears, de-
pending on the operating system.
If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the "USB" port is added to the [Printers] window.

AAAA Turn off the power of the machine.

BBBB Connect the machine with the computer via USB cable.

Connect the USB cable firmly.

CCCC Turn on the power of the computer.

DDDD Click [Next>].

EEEE Click [Search for the best driver for your device. {Recommended}.], and then click
[Next>].

FFFF Select the [Specify a location:] check box, and then click [Browse...].

The [Browse for Folder] dialog box appears.

GGGG Insert the CD-ROM into the CD-ROM drive.

Note
❒ When Auto Run starts, click [Exit].
❒ To disable Auto Run, press the {{{{Shift}}}} key when inserting the CD-ROM

into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.
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HHHH Specify the location where USB Printing Support is located, and then click
[Next>].
If the CD-ROM drive is D, the source files of USB Printing Support are stored
in the following location:
D:\DRIVERS\RPCS\WIN9X_ME

IIII Check the location, and then click [Next].

USB Printing Support is installed.

JJJJ Click [Finish].

If the printer driver has already been installed, plug and play is enabled, and
the icon of the printer connected to the "USB001" port is added to the [Printers]
window.

KKKK Click [Next>].

LLLL Click [Search for the best driver for your device. {Recommended}.], and then click
[Next>].

MMMM Select the [Specify a location:], check box, and then click [Browse...].

The [Browse for Folder] dialog box appears.

NNNN Insert the CD-ROM into the CD-ROM drive.

Note
❒ When Auto Run starts, click [Exit].
❒ To disable Auto Run, press the {{{{Shift}}}} key when inserting the CD-ROM

into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

OOOO Specify the location where the source files of the printer driver is stored,
and then click [Next>].

If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:
• RPCS

D:\DRIVERS\RPCS\WIN9X_ME\(Language)\DISK1
• PCL 6

D:\DRIVERS\PCL6\WIN9X_ME(Language)\DISK1\
• PCL 5e

D:\DRIVERS\PCL5E\WIN9X_ME(Language)\DISK1\
• PostScript 3

D:\DRIVERS\PS3\WIN9X_ME\(Language)\DISK1

PPPP Check the location, and then click [Next].

Add Printer Wizard starts.
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QQQQ Click [Finish].

Installation is complete. If installation is successful, the icon of the printer
connected to the "USB001" port is added to the [Printers] window.

Note
❒ The number after "USB" varies depending on the number of printers con-

nected.
❒ It is not necessary to reinstall USB Printing Support when connecting a dif-

ferent machine via USB interface when USB Printing Support is installed.
❒ After installing USB Printing Support, if the printer driver is not installed,

follow the plug-and-play instructions of the printer.

Windows 2000 - USB

Important
❒ Installing a printer driver requires Administrators permission. Log on using

an account that has Administrators permission.
When USB is first used, Found New Hardware Wizard starts, and USB Printing
Support is installed automatically.
If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the "USB" port is added to the [Printers] window.
If the printer driver is not installed, follow the plug-and-play instructions of the
printer to install it from the CD-ROM provided.

AAAA Turn off the power of the machine.

BBBB Connect the machine with the computer via USB cable.
Connect the USB cable firmly.

CCCC Turn on the power of the computer.

DDDD Click [Next] in the [Found New Hardware Wizard] dialog box.

EEEE "Select the [Search for a suitable driver for my device (recommended)] check box,
and then click [Next]."

FFFF Select the [Specify location] check box, and then click [Next].

GGGG Insert the CD-ROM into the CD-ROM drive.

Note
❒ When Auto Run starts, click [Exit].
❒ To disable Auto Run, press the left {{{{Shift}}}} key when inserting the CD-ROM

into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.
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HHHH Specify the location where the source files of the printer driver is stored.

If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:
• RPCS

D:\DRIVERS\RPCS\WIN2K_XP\(Language)\DISK1
• PCL 6

D:\DRIVER\SPCL6\WIN2K_XP\(Language)\DISK1
• PCL 5e

D:\DRIVERS\PCL5E\WIN2K_XP\(Language)\DISK1
• PostScript 3

D:\DRIVERS\PS3\WIN2K_XP\(Language)\DISK1

IIII Check the printer driver location, and then click [OK].

JJJJ Click [Next].

KKKK Click [Finish].

If the printer driver has already been installed, plug and play is enabled, and
the icon of the printer connected to the "USB001" port is added to the [Printers]
window.

Note
❒ The number after “USB” varies depending on the number of printers con-

nected.

Windows XP, Windows Server 2003 - USB

Important
❒ Installing a printer driver requires Administrators permission. Log on using

an account that has Administrators permission.
When USB is first used, Found New Hardware Wizard starts, and USB Printing
Support is installed automatically.
If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the "USB" port is added to the [Printers] window.
The printer drivers can be installed from the CD-ROM provided with this ma-
chine.
If the printer driver is not installed, follow the plug-and-play instructions of the
printer to install it from the CD-ROM provided.

AAAA Turn off the power of the printer.

BBBB Connect the machine with the computer via USB cable.

Connect the USB cable firmly.

CCCC Turn on the power of the computer.
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DDDD In the Found New Hardware Wizard display, click [Search for a suitable driver
for my device [recommended] ], and then click [Next>].

EEEE To disable Auto Run, press the left {{{{SHIFT}}}} key when inserting the CD-
ROM into the drive and keep it pressed until the computer finishes reading
from the CD-ROM.

Note
❒ If Auto Run starts, click [Cancel], and then [Exit].

FFFF Select the [Include this location in the search] check box under [Search for the best
driver in these location], and then click [Browse] to select the printer driver lo-
cation.

If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:
• RPCS

D:\DRIVERS\RPCS\WIN2K_XP\(Language)\DISK1
• PCL 6

D:\DRIVERS\PCL6\WIN2K_XP\(Language)\DISK1
• PCL 5e

D:\DRIVERS\PCL5E\WIN2K_XP\(Language)\DISK1
• PostScript 3

D:\DRIVERS\PS3\WIN2K_XP\(Language)\DISK1

GGGG Check the printer driver location, and then click [Next].

HHHH Click [Continue].

IIII Click [Finish].

If installation is successful, the icon of the printer connected to the "USB001"
port is added to the [Printers] window.

Note
❒ The number after “USB” varies depending on the number of printers con-

nected.
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Troubleshooting USB

Problems Solutions

The machine is not automatically recognized. Turn off the power of the machine, reconnect 
the USB cable, and then turn it on again.

Windows has already configured the USB set-
tings.

Open Windows' Device Manager, and then, 
under [Universal Serial Bus controllers], remove 
any conflicting devices. Conflicting devices 
have a yellow [!] or [?] icon by them. Take care 
not to accidentally remove required devices. 
For details, see Windows Help.

Note
❒ When using Windows 2000/XP or Win-

dows Server 2003, an erroneous device is 
displayed under [USB Controller] in the [De-
vice Manager] dialog box.
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Printing with Parallel Connection

To use a machine connected using a parallel interface, click [LPT1] when install-
ing the printer driver.

Installing the PCL or RPCS Printer Driver

Important
❒ To install this printer driver under Windows 2000/XP Professional, Windows

Server 2003, and Windows NT 4.0, you must have an account that has Man-
age Printers permission. Log on as an Administrators or Power Users group
member.

AAAA Quit all applications currently running.

BBBB Insert the CD-ROM into the CD-ROM drive.

The installer starts.
Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

CCCC Select an interface language, and then click [OK].

The default interface language is English.

DDDD Click [PCL/RPCS Printer Drivers].

EEEE The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [I accept the agreement], and then click [Next].

FFFF Select a printer driver you want to use in the [Select Program] dialog box. 

You can select several printer drivers.

GGGG Select the [Printer Name] check box to select the printer models you want to
use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

HHHH Double-click the printer name to display the printer settings.

The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

IIII Check that [LPT1:] is shown in [Port:].

JJJJ Select the [Default Printer] check box to configure the printer as default.

KKKK Click [Finish].
The printer driver installation starts.
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LLLL Click [Finish] in the installation completion dialog box.

Note
❒ To stop installation of the selected software, click [Cancel] before installa-

tion is complete. Restart the computer and reinstall other software pro-
grams or printer drivers.

Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See p.58 “If a
Message Appears during Installation”.
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Installing the Printer Driver Using IEEE 1394 
(SCSI print)

The printer drivers can be installed from the CD-ROM provided with this machine. 

Important
❒ Quit all applications currently running, and do not print during installation.
❒ Do not connect IEEE 1394 or USB devices to the computer or turn on another

printers during installation.
❒ Before uninstalling the printer driver, check that the IEEE 1394 interface cable

is disconnected from the computer.
❒ SCSI print must be set to "active" from the control panel. For details, see Net-

work Guide.
❒ This machine can receive print data from one computer at a time only. An

message may appear if jobs from different computers collide.
❒ If jobs collide, the first received is printed first.
❒ When the printer driver is properly installed, connecting or disconnecting the

optional IEEE 1394 cable causes the printer icon to change.

Windows 2000

Note
❒ If [Found New Hardware Wizard] appears every time the computer is started or

the cable is connected, disable the device. To install another printer driver af-
ter setting the "1394_00n" port, click [1394_00] as a port during the printer
driver installation.

❒ Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

❒ The optional 1394 interface unit can be used only with Service Pack 1 (SP1) or
higher.

AAAA Connect the machine and computer using the IEEE 1394 interface cable.

BBBB Click [Next] in the [Found New Hardware Wizard] dialog box.

CCCC When the message "This wizard will complete the installation for this De-
vice: Unknown" appears, click [Specify a location], and then click [Next>].

DDDD When the message "Locate Driver Files" appears, select the [Optional search
locations.] check box, and then click [Specify a location], and then click [Next>].

EEEE To disable Auto Run, press the left {{{{SHIFT}}}} key when inserting the CD-
ROM into the drive and keep it pressed until the computer finishes reading
from the CD-ROM.

If Auto Run starts, click [Cancel], and then [Exit].
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FFFF Click [Browse].

GGGG Select the printer driver you want to use.

If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:
• RPCS

D:\DRIVERS\RPCS\WIN2K_XP\(Language)\DISK1
• PCL 6

D:\DRIVERS\PCL6\WIN2K_XP\(Language)\DISK1
• PCL 5e

D:\DRIVERS\PCL5E\WIN2K_XP\(Language)\DISK1
• PostScript 3

D:\DRIVERS\PS3\WIN2K_XP\(Language)\DISK1

HHHH Click [Open].

IIII Click [OK].

JJJJ Follow the instructions.

When installation is complete, the printer connected to "1394_00n" appears in
the [Printers] window. ("n" shows the number of printers connected.)

Note
❒ If the printer driver has already been installed, the printer icon is added to

the [Printers] window. In this case, printer driver installation is not neces-
sary.

❒ If printing does not work properly after the installation, delete the port and
reinstall the printer driver. For details, see "Printer Does Not Print", Main-
tenance Guide.

❒ If you do not want to install the printer when Found New Hardware Wiz-
ard starts under an operating system that supports SCSI print, disable the
device by following the procedure below.
A When the [Found New Hardware Wizard] dialog box appears, click [Next>].
B When the message "This wizard will complete the installation for this

Device: Unknown" appears, select the [Search for a suitable driver for my de-
vice recommended] check box, and then click [Next>].

C When the message "Please choose your search and installation option."
appears, clear all check boxes from [Search for the best driver in these loca-
tions.], and then click [Next>].

D When the message "Driver Files Search Results" appears, select the [Dis-
able the device. The Add/Remove Hardware Wizard in the control Panel can be
able to complete the driver installations.] check box, and then click [Finish]."
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Windows XP, Windows Server 2003

Important
❒ SCSI print must be set to "active" from the control panel. For details, see Net-

work Guide.
❒ Installing this printer driver requires Administrators permission. Log on us-

ing an account that has Administrators permission.

Note
❒ This machine can receive print data from one computer at a time only. If a job from

a computer collides with other data, a message may appear on the computer.
❒ To install another printer driver after setting the "1394_00n" port, click

[1394_00] as a port during the printer driver installation.
❒ When the printer driver is properly installed, connecting or disconnecting the

optional IEEE 1394 cable causes the printer icon to change.

AAAA Connect the machine and computer using the IEEE 1394 interface cable.

When the [Found New Hardware Wizard] dialog box appears, check that [This wiz-
ard helps you install software for: (Unknown)] is displayed.

BBBB Select the [Install from a list on specific location (Advanced)] check box, and then
click [Next>].

CCCC When the message "Please choose your search and installation option." ap-
pears, select the [Search for the best driver in these locations.] check box, select
the [Include this location in the search:] check box, and then select the [Include
this location in the search:] check box.

DDDD To disable Auto Run, press the left {{{{SHIFT}}}} key when inserting the CD-
ROM into the drive and keep it pressed until the computer finishes reading
from the CD-ROM.

Note
❒ If Auto Run starts, click [Cancel], and then [Exit].

EEEE Specify the location where the source files of the printer driver is stored,
and then click [Next].
If the CD-ROM drive is D,  the source files of the printer driver are stored in
the following location:
• RPCS

D:\DRIVERS\RPCS\WIN2K_XP\(Language)\DISK1
• PCL 6

D:\DRIVERS\PCL6\WIN2K_XP\(Language)\DISK1
• PCL 5e

D:\DRIVERS\PCL5E\WIN2K_XP\(Language)\DISK1
• PostScript 3

D:\DRIVERS\PS3\WIN2K_XP\(Language)\DISK1
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When installation is complete, the printer connected to "1394_00n" appears in
the [Printers and Faxes] window. ("n" shows the number of printers connected.)

FFFF Follow the instructions.

Note
❒ If the printer driver has already been installed, the printer icon is added to

the [Printers and Faxes] window. In this case, printer driver installation is
not necessary.

❒ Even if the printer driver is already installed, the message " Found New
Hardware Wizard" may appear when the machine and the computer are
connected using the IEEE 1394 interface cable for the first time. If it does,
install the printer driver.

❒ If printing does not work properly after the installation, delete the port and
reinstall the printer driver. For details, see "Printer Does Not Print", Main-
tenance Guide.

❒ If you do not want to install the printer when Found New Hardware Wiz-
ard starts under an operating system that supports SCSI print, disable the
device by following the procedure below
A When the [Found New Hardware Wizard] dialog box appears, check that

[This wizard helps you install software for: Unknown] displayed, select [Install
from a list on specific location (Advanced)] check box, and then click [Next>].

B When the message "Please choose your search and installation option."
appears, clear all check boxes from [Search for the best driver in these loca-
tions.], and then click [Next>].

C When the message "The wizard could not find the software on your
computer for.." appears, click [OK].

D When the message "Cannot Install this Hardware" appears, select the
[Don't prompt again to install the software] check box, and then click [Finish].
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Printing with Bluetooth™ Connection

Supported Profiles

❖❖❖❖ SPP, HCRP
• A maximum of two Bluetooth adaptor or Bluetooth-equipped computers

can be connected at the same time using the Bluetooth interface: one by
SPP, one by HCRP.

• When connecting more than one Bluetooth adaptor or Bluetooth-equipped
computer at the same time, the first device that establishes connection is se-
lected. When selecting the connection between the other devices, cancel
the first established connection.

• Conditions for bidirectional communications
• SPP connection does not support bidirectional communications.
• HCRP connection supports bidirectional communications.

❖❖❖❖ BIP
• For BIP connection, a module including PostScript 3 must be installed in

the machine.
• Only one Bluetooth adaptor or Bluetooth-equipped computer can be con-

nected via BIP.
• Only JPEG images that can be printed using BIP.
• User codes are disabled for BIP.

You cannot print if print functions are restricted.
• Some printers do not support BIP.

Printing with Bluetooth™ Connection

To install the printer driver, follow the procedure used to install parallel inter-
face.

Important
❒ To install the printer driver under Windows 2000/XP Professional, Windows

Server 2003, and Windows NT 4.0, you must have an account that has Man-
age Printers permission. Log on as an Administrators or Power Users group
member.

Note
❒ System requirements vary depending on the Bluetooth standard and specifi-

cations. For details, see the manuals provided with each product.
❒ For information about setting up Bluetooth under other operating systems or

using it with different utilities, see the manuals provided with those operat-
ing systems or utilities.
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AAAA Start 3Com Bluetooth Connection Manager.

BBBB Check that the printer you want to use appears in 3Com Bluetooth Connec-
tion Manager.

CCCC On the [Tool] menu, click [COM port].

DDDD Check that the message "Bluetooth Serial Client (COMx) " appears under
Client Ports. (X indicates the COM port number used by Bluetooth™.)

EEEE Click [Close].

FFFF On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

GGGG Click the icon of the printer you want to use.

HHHH On the [File] menu, click [Properties].

IIII Click the [Ports] tab.

JJJJ Under [Port], select the [COMx:] check box. X indicates the COM port
number used by Bluetooth™.

KKKK Click [OK].

Close the [Printers] window.

❖❖❖❖ If a dialog box appears while transmitting a print job, reestablish network connec-
tion as follows:
A Select the printer you want to use in the [Printers and Fax] box.
B Click [Connect].

Note
❒ To always use the same printer, select the [Always use for this connection]

check box.

Reference
For details, see the manuals provided with the Bluetooth adaptor or
computer equipped with Bluetooth.
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Configuring Security Mode Settings

AAAA Start 3Com Bluetooth Connection Manager.

BBBB On the [Tools] menu, click [Security Mode].

The [Security Mode] dialog box appears.

CCCC Select the security mode in the [Security Mode:] list.

If you click [High], or [Custom], and specify [Link] in the [Custom Settings] dialog
box, enter the Bluetooth password. For information about entering the pass-
word, see p.57 “Printing in the Security Mode” 
 For all other security modes and custom settings, no password is required.

Note
❒ For information about each mode, see the manuals provided with the util-

ity.

DDDD Click [OK].

Close the [Security Mode] dialog box.

Reference
For details about the security mode, see 3Com Bluetooth Connection Man-
ager Help. For details about the password entry which is required to trans-
mit print jobs, see p.57 “Printing in the Security Mode”.

Printing in the Security Mode

AAAA Send the print job to the printer in use.

Depending on the computer configuration, the [Connect] dialog box may ap-
pear. If it does, use it to establish the network connection.

BBBB The [Authentication] dialog box appears.

CCCC Enter the Bluetooth password, and then click [OK].

As the Bluetooth password, enter the last four digits of the machine's serial
number. You can find the serial number on the label on the back of the ma-
chine. For example, if the serial number is 00A0-001234, the Bluetooth pass-
word is 1234.

DDDD The print job is sent.

Note
❒ The Bluetooth password differs for each machine and cannot be changed.
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If a Message Appears during Installation

Message number 58 or 34 indicates the printer driver cannot be installed using
Auto Run. Install the printer driver using [Add Printer] or [>Install Printer].

For Windows 95/98/Me, Windows 2000 and Windows NT 4.0:

AAAA On the [Start] menu, point to [Settings], and then click [Printers].

BBBB Double-click the Add Printer icon.

CCCC Follow the instructions in Add Printer Wizard.

Note
❒ If the printer driver is on a CD-ROM, the location of the RPCS printer driver

is either \DRIVERS\RPCS\WIN9X_ME, \DRIVERS\RPCS\WIN2K_XP, or
DRIVERS\RPCS\NT4. If the installer starts, click [Cancel] to quit.

For Windows XP Professional and Windows Server 2003:

AAAA On the [Start] menu, click [Printers and Faxes].

BBBB Click [Add a printer].

CCCC Follow the instructions in Add Printer Wizard.

Note
❒ If the printer driver is on a CD-ROM, the location of the RPCS printer driver

is \DRIVERS\RPCS\WIN2K_XP. If the installer starts, click [Cancel] to quit.

For Windows XP Home Editions:

AAAA On the [Start] menu, click [Control Panel].

BBBB Click [Printers and Other Hardware].

CCCC Click [Printers and Faxes].

DDDD Click [Install Printer].

EEEE Follow the instructions in Add Printer Wizard.

Note
❒ If the printer driver is on a CD-ROM, the location of the RPCS printer driver

is \DRIVERS\RPCS\WIN2K_XP. If the installer starts, click [Cancel] to quit.
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Making Option Settings for the Printer

Make option settings for the machine using the printer driver when bidirectional
communication is disabled.

Reference
For details about making option settings for the printer, see p.61 “If Bidirec-
tional Communication is Disabled”.

Conditions for Bidirectional Communication

Bidirectional communication allows information about paper size and feed di-
rection settings to be automatically sent to the printer. You can check machine
status from your computer.
• Bidirectional communication is supported by Windows 95/98/Me/2000/XP,

Windows Server 2003, and Windows NT 4.0.
• If you use the RPCS printer driver and bidirectional communication is ena-

bled under Windows 2000, the [Change Accessories] tab is unavailable. 

Note
❒ The RPCS printer driver supports bidirectional communications and updates

the machine status automatically.
❒ The PCL printer driver supports bidirectional communications. You can up-

date machine status manually.
❒ The PostScript 3 printer driver does not support bidirectional communica-

tions.
To support bidirectional communication, the following conditions must be met:

❖❖❖❖ When connected with parallel cables
• The computer must support bidirectional communication.
• The machine must support bidirectional communication.
• The interface cable must support bidirectional communication.
• The machine must be connected to the computer using the standard paral-

lel cables and parallel connectors.
• Under Windows 2000, [Enable bidirectional support] must be selected, and

[Enable printer pooling] must not be selected on the [port] tab with the RPCS
printer driver.
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❖❖❖❖ When connected with the network
• The machine must support bidirectional communication.
• SmartDeviceMonitor for Client included on the CD-ROM must be installed,

and TCP/IP must be used.
• Under Windows 2000, [Enable bidirectional support] must be selected, and

[Enable printer pooling] must not be selected on the [port] tab with the RPCS
printer driver.

• In addition to the above, one of the following conditions must also be met:
• The SmartDeviceMonitor for Client port and the TCP/IP protocol must

be used.
•  The standard TCP/IP port must be used without changing the default

port name (for Windows 2000/XP and Windows Server 2003).
• Microsoft TCP/IP print IP address must be specified for use (for Win-

dows NT 4.0).
• IPP port name must include the IP address when using the IPP protocol.

❖❖❖❖ When connected with IEEE 1394
• The computer must support bidirectional communication.
• The machine must be connected to the IEEE 1394 connector of a computer

using the IEEE 1394 interface cable.
•  [Activate] must be selected in the SCSI print of IEEE 1394 and [Activate]

must be selected in the Bidi-SCSI print.
• Under Windows 2000/XP or Windows Server 2003, [Enable bidirectional

support] must be selected, and [Enable printer pooling] must not be selected
on the [port] tab with RPCS printer driver.

❖❖❖❖ When connected with USB
The machine must be connected to the computer's USB port using the USB in-
terface cable.
The computer must support bidirectional communication.

Note
❒ Install SmartDeviceMonitor for Client from the CD-ROM provided.
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If Bidirectional Communication is Disabled

Set up option settings when bidirectional communications are disabled.

Limitation
❒ Under Windows 2000/XP and Windows Server 2003, Manage Printers per-

mission is required to change the printer properties in the [Printers] folder.
Log on as an Administrators or Power Users group member.

❒ Under Windows NT 4.0, Full Control permission is required to change the
printer properties in the [Printers] folder. Log on as an Administrators or Pow-
er Users group member.

AAAA On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click the icon of the printer you want to use.

CCCC On the [File] menu, click [Properties].

DDDD Click the [Accessories] tab.

If options in the [Change Accessories] tab are disabled, bidirectional connection
is enabled. In this case, no change is necessary for option settings.

Note
❒ If you are using the RPCS printer driver, click the [Change Accessories] tab.
❒ If you are using the PS printer driver, click the [Device Settings] tab.

EEEE Select options installed from the [Option] area, and then make the necessary
settings.

FFFF Select the total amount of the memory in [Total memory:], when the optional
SDRAM module is added.

GGGG Under [Paper source tray settings], click and highlight the tray to be used, and
then select the appropriate size, position, and type for the tray. Select the
[Tray locking] check box to exclude the tray from the targets of automatic tray
selection.

HHHH Click [OK] to close the printer properties dialog box. Click the [Defaults] tab,
and then click [Change Accessories] to display the option selection.
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Installing Font Manager 2000

Limitation
❒ Under Windows 2000/XP, Windows Server 2003, or Windows NT 4.0, install-

ing applications by Auto Run requires administrator permission. To install a
printer driver by Auto Run, log on using an account that has administrator
permission.

AAAA Quit all applications currently running.

BBBB Insert the CD-ROM into the CD-ROM drive.

The installer starts.

CCCC Click [Font Manager 2000].

DDDD Follow the instructions on the screen.

MartiniC25-EN-Pref-F5_FM.book  Page 62  Thursday, December 9, 2004  10:59 AM



Using Adobe PageMaker Version 6.0, 6.5, or 7.0

63

2

Using Adobe PageMaker Version 6.0, 6.5, 
or 7.0

Under Windows 95/98/Me/2000/XP, Windows Server 2003, or Windows NT
4.0 with Adobe PageMaker, you need to copy PPD files to the PageMaker folder.
PPD files have the .ppd extension in the folder “DRIVERS\PS\WIN9X_ME
\(Language)\DISK1\” on the CD-ROM.
The “WIN9X_ME” folder inside the “PS” folder is for Windows 95/98/Me. Use
the folder at this level that is appropriate for the operating system you are cur-
rently using.
The third folder “(Language)” may be substituted by an appropriate language
name.
Copy the .ppd file to the PageMaker folder.
•  For PageMaker 6.0 default installation 

The directory is “C:\PM6\RSRC\PPD4”.
•  For PageMaker 6.5 default installation 

The directory is “C:\PM65\RSRC\USENGLISH\PPD4”.
The “USENGLISH” may vary depending on your language selection.

•  For PageMaker 7.0 default installation 
The directory is “C:\PM7\RSRC\USENGLISH\PPD4”.
The “USENGLISH” may vary depending on your language selection.

Note
❒ If the driver is not set correctly after copying the “.ppd” file, printing may not

be performed properly.
❒ When using PageMaker, the optional features that can be selected by the

printer driver will not be active. The following procedure describes how to
activate the optional printer features.
A On the [File] menu, click [Print].

The [Print Document] dialog box appears.
B Make the necessary settings in the [Features] box.
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3. Setting Up the Printer Driver

PCL - Accessing the Printer Properties

Windows 95/98/Me - Accessing the Printer Properties

There are two methods to open the printer properties dialog box.

Making printer default settings

To make the printer default settings, open the printer properties dialog box from
the [Printers] window.

Important
❒ You cannot change the printer default settings for each user. Settings made in

the printer properties dialog box are applied to all users.

AAAA On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click the icon of the printer you want to use.

CCCC On the [File] menu, click [Properties].

DDDD Make the necessary settings, and then click [OK].

Note
❒ With some applications, the printer driver settings are not used, and the

application's own default settings are applied.

Reference
For details, see Printer Driver Help. 

Making printer settings from an application

You can make printer settings for a specific application.
To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 95/98/Me.

AAAA On the [File] menu, click [Print].

The [Print] dialog box appears.

BBBB Select the printer you want to use in the [Name] list, and then click [Properties].

The printer properties dialog box appears.

CCCC Make the necessary settings, and then click [OK].
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DDDD Click [OK] to start printing.

Note
❒ The procedure to open the printer properties dialog box may vary depend-

ing on the application. For details, see the manuals provided with the ap-
plication you use.

❒ With some applications, the printer driver settings are not used, and the
application's own default settings are applied.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

Reference
For details, see Printer Driver Help. 
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Windows 2000 - Accessing the Printer Properties

Making printer default settings - the printer properties

Important
❒ To change the printer default settings including option configuration settings,

log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission
by default.

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

AAAA On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click the icon of the printer you want to use.

CCCC On the [File] menu, click [Properties].

The printer properties dialog box appears.

DDDD  Make the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.
❒ Do not make a setting for [Form to Tray Assignment].

Reference
For details, see Printer Driver Help. 

Making printer default settings - Printing Preferences

Important
❒ You cannot change the printer default settings for each user. Settings made in

the printer properties dialog box are applied to all users.

AAAA On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

BBBB Click the icon of the printer you want to use.

CCCC On the [File] menu, click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

DDDD Make the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.
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Reference
For details, see Printer Driver Help. 

Making printer settings from an application

You can make printer settings for a specific application.
To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 2000.

Note
❒ The procedure to open the [Printing Preferences] dialog box may vary depend-

ing on the application. For details, see the manuals provided with the appli-
cation you use.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

AAAA On the [File] menu, click [Print...].

The [Print] dialog box appears.

BBBB Select the printer you want to use in the [Select Printer] list.

CCCC Make the necessary settings, and then click [Apply] to start printing.

Reference
For details, see Printer Driver Help. 
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Windows XP, Windows Server 2003 - Accessing the Printer Properties

Making printer default settings - the printer properties

Important
❒ To change the printer default settings including option configuration settings,

log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission
by default. 

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

AAAA On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

BBBB Click the icon of the printer you want to use.

CCCC On the [File] menu, click [Properties].

The printer properties dialog box appears.

DDDD  Make the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.
❒ Do not make a setting for [Form to Tray Assignment].

Reference
For details, see Printer Driver Help. 

Making printer default settings - Printing Preferences

Important
❒ You cannot change the printer default settings for each user. Settings made in

the printer properties dialog box are applied to all users.

AAAA On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

BBBB Click the icon of the printer you want to use.

CCCC On the [File] menu, click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

DDDD Make the necessary settings, and then click [OK].
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Note
❒ Settings you make here are used as the default settings for all applications.

Reference
For details, see Printer Driver Help. 

Making printer settings from an application

You can make printer settings for a specific application.
To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows XP.

Note
❒ The procedure to open the [Printing Preferences] dialog box may vary depend-

ing on the application. For details, see the manuals provided with the appli-
cation you use.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

AAAA On the [File] menu, click [Print...].

The [Print] dialog box appears.

BBBB Select the printer you want to use in the [Select Printer] list.

CCCC Make the necessary settings, and then click [Apply] to start printing.

Reference
For details, see Printer Driver Help. 
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Windows NT 4.0 - Accessing the Printer Properties

Making printer default settings - the printer properties

Important
❒ To change the printer default settings including option configuration settings,

log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default. 

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

AAAA On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click the icon of the printer you want to use.

CCCC On the [File] menu, click [Properties].

The printer properties dialog box appears.

DDDD Make the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.
❒ Do not make a setting for [Form to Tray Assignment].

Reference
For details, see Printer Driver Help. 

Making printer default settings - Default

Important
❒ To change the printer default settings including option configuration settings,

log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default. 

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

AAAA On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

BBBB Click the icon of the printer you want to use.

CCCC On the [File] menu, click [Document Defaults].

The [Default] dialog box appears.
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DDDD Make the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.

Reference
For details, see Printer Driver Help. 

Making printer settings from an application

You can make printer settings for a specific application.
To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows NT 4.0.

Note
❒ The procedure to open the printer properties dialog box may vary depending

on the application. For details, see the manuals provided with the application
you use.

❒ With some applications, the printer driver settings are not used, and the ap-
plication's own default settings are applied.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

AAAA On the [File] menu, click [Print].
The [Print] dialog box appears.

BBBB Select the printer you want to use in the [Name] list, and then click [Properties].
The printer properties dialog box appears.

CCCC Make the necessary settings, and then click [OK].

DDDD Click [OK] to start printing.

Reference
For details, see Printer Driver Help. 
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RPCS - Accessing the Printer Properties

Windows 95/98/Me - Accessing the Printer Properties

There are two dialog box types of the printer properties dialog box.
"Multi-tab" is used as an example in this manual. For details about changing the
dialog box types, see the printer driver Help.

❖❖❖❖ Multi-tab
This dialog box type is designed for users who often change print settings to
perform various printing operations.

❖❖❖❖ Custom Setting
This dialog box type is designed for users who rarely change print settings.
This type of dialog box may vary depending on the installed options.

Making printer default settings

To make the printer default settings, open the printer properties dialog box from
the [Printers] window.

Important
❒ You cannot change the printer default settings for each user. Settings made in

the printer properties dialog box are applied to all users.

Note
❒ With some applications, the printer driver settings are not used, and the ap-

plication's own default settings are applied.

AAAA On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click the icon of the printer you want to use.

CCCC On the [File] menu, click [Properties].

Note
❒ When you open the printer properties dialog box initially after installing

the RPCS printer driver, a confirmation message appears. After clicking
[OK], the printer properties dialog box appears.

DDDD Make the necessary settings, and then click [OK].

Reference
For details, see Printer Driver Help. 
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Making printer settings from an application

You can make printer settings for a specific application.
To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 95/98/Me.

Note
❒ The procedure to open the printer properties dialog box may vary depending

on the application. For details, see the manuals provided with the application
you use.

❒ With some applications, the printer driver settings are not used, and the ap-
plication's own default settings are applied.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

AAAA On the [File] menu, click [Print].
The [Print] dialog box appears.

BBBB Select the printer you want to use in the [Name] list, and then click [Properties].
The printer properties dialog box appears.

CCCC Make the necessary settings, and then click [OK].

DDDD Click [OK] to start printing.

Reference
 For details, see Printer Driver Help. 
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Windows 2000 - Accessing the Printer Properties

Making printer default settings - the printer properties

Important
❒ To change the printer default settings including option configuration settings,

log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission
by default. 

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

AAAA On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click the icon of the printer you want to use.

CCCC On the [File] menu, click [Properties].

The printer properties dialog box appears.

Note
❒ When you open the printer properties dialog box initially after installing

the RPCS printer driver, a confirmation message appears. After clicking
[OK], the printer properties dialog box appears.

DDDD  Make the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.
❒ Do not make a setting for [Form to Tray Assignment].

Reference
For details, see Printer Driver Help. 

Making printer default settings - Printing Preferences

Important
❒ You cannot change the printer default settings for each user. Settings made in

the printer properties dialog box are applied to all users.

AAAA On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click the icon of the printer you want to use.
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CCCC On the [File] menu, click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

DDDD Make the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.

Reference
For details, see Printer Driver Help. 

Making printer settings from an application

You can make printer settings for a specific application.
To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 2000.

Note
❒ The procedure to open the [Printing Preferences] dialog box may vary depend-

ing on the application. For details, see the manuals provided with the appli-
cation you use.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

AAAA On the [File] menu, click [Print...].

The [Print] dialog box appears.

BBBB Select the printer you want to use in the [Select Printer] list.

CCCC Make the necessary settings, and then click [Apply] to start printing.

Reference
For details, see Printer Driver Help. 
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Windows XP, Windows Server 2003 - Accessing the Printer Properties

Making printer default settings - the printer properties

Important
❒ To change the printer default settings including option configuration settings,

log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission
by default. 

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

AAAA On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

BBBB Click the icon of the printer you want to use.

CCCC On the [File] menu, click [Properties].

The printer properties dialog box appears.

Note
❒ When you open the printer properties dialog box initially after installing

the RPCS printer driver, a confirmation message appears. After clicking
[OK], the printer properties dialog box appears.

DDDD  Make the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.
❒ Do not make a setting for [Form to Tray Assignment].

Reference
For details, see Printer Driver Help. 

Making printer default settings - Printing Preferences

Important
❒ You cannot change the printer default settings for each user. Settings made in

the printer properties dialog box are applied to all users.

AAAA On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

BBBB Click the icon of the printer you want to use.

MartiniC25-EN-Pref-F5_FM.book  Page 77  Thursday, December 9, 2004  10:59 AM



Setting Up the Printer Driver

78

3

CCCC On the [File] menu, click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

DDDD Make the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.

Reference
For details, see Printer Driver Help. 

Making printer settings from an application

You can make printer settings for a specific application.
To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows XP.

Note
❒ The procedure to open the [Printing Preferences] dialog box may vary depend-

ing on the application. For details, see the manuals provided with the appli-
cation you use.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

AAAA On the [File] menu, click [Print...].

The [Print] dialog box appears.

BBBB Select the printer you want to use in the [Select Printer] list.

CCCC Make the necessary settings, and then click [Apply] to start printing.

Reference
For details, see Printer Driver Help. 
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Windows NT 4.0 - Accessing the Printer Properties

Making printer default settings - the printer properties

Important
❒ To change the printer default settings including option configuration settings,

log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

AAAA On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click the icon of the printer you want to use.

CCCC On the [File] menu, click [Properties].

The printer properties dialog box appears.

Note
❒ When you open the printer properties dialog box initially after installing

the RPCS printer driver, a confirmation message appears. After clicking
[OK], the printer properties dialog box appears.

DDDD Make the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.
❒ Do not make a setting for [Form to Tray Assignment].

Reference
For details, see Printer Driver Help. 

Making printer default settings - Default

Important
❒ To change the printer default settings including option configuration settings,

log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default. 

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

AAAA On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.
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BBBB Click the icon of the printer you want to use.

CCCC On the [File] menu, click [Document Defaults...].

The [Default] dialog box appears.

DDDD Make the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.

Reference
For details, see Printer Driver Help. 

Making printer settings from an application

You can make printer settings for a specific application.
To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows NT 4.0.

Note
❒ The procedure to open the printer properties dialog box may vary depending

on the application. For details, see the manuals provided with the application
you use.

❒ With some applications, the printer driver settings are not used, and the ap-
plication's own default settings are applied.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

AAAA On the [File] menu, click [Print].

The [Print] dialog box appears.

BBBB Select the printer you want to use in the [Name] list, and then click [Proper-
ties].
The printer properties dialog box appears.

CCCC Make the necessary settings, and then click [Apply].

DDDD Click [OK] to start printing.

Reference
For details, see Printer Driver Help. 
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4. Other Print Operations

Printing a PDF File Directly

You can send PDF files directly to the
machine for printing, without having
to open a PDF application.

Limitation
❒ This function is possible only when

the optional PostScript 3 unit is in-
stalled.

❒ This function is possible for genu-
ine Adobe PDF files only.

❒ Version 1.3, 1.4, and 1.5 PDF files
are compatible.

❒ Transparency and JBIG2 (functions
of PDF version 1.4) are not compat-
ible.

❒ PDF version 1.5 exclusive func-
tions are not compatible. 

Note
❒ Paper size errors may occur when

printing on custom size paper.

Printing Method

❖❖❖❖ Using DeskTopBinder Lite
PDF files registered with Desk-
TopBinder Lite can be sent directly
to the machine for printing.

Limitation
❒ Use DeskTopBinder Lite on the

provided CD-ROM.

Note
❒ PDF Direct Print settings can be

made from PDF Direct Print
properties. 

❒ When printing PDF files for
which a password is set, one of
the following settings is re-
quired:

• Enter the PDF password from
PDF Direct Print properties.
The RPCS printer driver must
be installed. 

• To set the PDF password, se-
lect [Change PDF Password] on
the [PDF Menu] in Printer Fea-
tures.

❒ When a group password is set
with DeskTopBinder Lite, set a
group password using [PDF
Group Password] on the [PDF
Menu] in Printer Features.

Reference
For details, see DeskTopBinder
Lite Help.

❖❖❖❖ Using commands
From UNIX, you can print PDF
files directly, using commands
such as “ftp” and “lpr”.
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Sample Print

Use this function to print only the first
set of a multiple-set print job. After
you have checked the result, remain-
ing sets can be printed or canceled us-
ing the machine's control panel. This
can reduce misprints due to mistakes
in content or settings.

Note
❒ Depending on the security set-

tings, certain print jobs may not be
displayed.

❒ If the application has a collate op-
tion, make sure it is not selected be-
fore sending a print job. By default,
sample print jobs are automatically
collated by the printer driver. If a
collate option is selected from the
application's [Print] dialog box,
more prints than intended may be
produced.

❒ You can identify the file you want
to print by user ID and date and
time when the job was stored.

❒ The number of pages the machine
can save depends on the contents
of the print image. For example,
the machine can save up to 30 jobs
or 2,000 pages, including locked
print files, depending on data vol-
ume.

❒ If the first set of the sample print
files is not as you expected and you
do not want to print remaining
sets, delete the sample print file us-
ing the display panel. If you print
the remaining sets of the sample
print file, the job in the machine is
deleted automatically.

❒ Turning off the machine's main
power switch deletes sample print
files.

Printing a Sample Print File

The following procedure describes
how to print a sample print file with
the PCL 6/5e and the RPCS printer
driver. For information about how to
print a sample print file with the Post-
Script 3 printer driver, see PostScript 3
Supplement included as a PDF file on
the CD-ROM.

Limitation
❒ Applications with their own driv-

ers, such as PageMaker, do not sup-
port this function.

❒ If you are using Mac OS X, this
function cannot be used.

AAAA Configure the sample print in the
printer driver's properties.

Reference
For details about configuring
the printer drivers, see the rele-
vant Help files.

BBBB Start printing from the applica-
tion's [Print] dialog box.

Note
❒ Make sure to set more than two

copies.
The sample print job is sent to the
machine, and the first set is printed.
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CCCC On the machine's control panel,
press the {{{{Printer}}}} key to display
the Printer screen.

DDDD Press [Locked & Sample Print Job
List].

EEEE Press [Sample Print Job List].
A list of the sample print files
stored in the machine appears.

The following items also appear:
• User ID:  The user ID set up by

the printer driver.
• Date / Time:  The date and time

when the job was sent from the
computer.

• Qty. : The number of remaining
sets.

FFFF Select the file you want to print
by pressing it.
A list of the print files stored in the
machine appears.

Note
❒ Press [UUUUPrevious] or [TTTTNext.] to

scroll through the list.
❒ Only one file can be selected at a

time.

GGGG Press [Print] to change the number
of sets to be printed.

HHHH Enter the new number of sets us-
ing the number keys.

If you do not want to change the
set quantity, proceed to step I.

Note
❒ You can enter up to 999 sets.
❒ Press {{{{Clear/Stop}}}} to correct any

entry mistakes.

IIII Press [Yes].

The remaining sets are printed.

Note
❒ Press [No] to cancel printing.
❒ When printing is completed, the

stored file will be deleted.
❒ To cancel printing, press [Exit].

After that, press [Job Reset]. Af-
ter it has started, the file will be
deleted.

❒ If there is a print job outstand-
ing, this will be printed before
the sample print job.

AEW015S
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Deleting a Sample Print File

If you are not satisfied with the sam-
ple printout, you can delete the sam-
ple print file, revise it and print it
again until the settings are suitable.

AAAA Press the {{{{Printer}}}} key to display
the Printer screen.

BBBB Press [Locked & Sample Print Job
List].

A list of the print files stored in the
machine appears.

CCCC Press [Sample Print Job List].

A list of sample print files stored in
the machine appears.

DDDD Select the file you want to delete
by pressing it.

Note
❒ Press [UUUUPrev.] or [TTTTNext.] to

scroll through the list.
❒ Only one file can be selected at a

time.

EEEE Press [Delete].

The delete confirmation screen
will appear.

FFFF Press [Yes] to delete the file.
After the file has been deleted, the
file list screen will return.

Note
❒ If you do not want to delete the

file, press [No].

Checking the Error Log

If a file could not be stored, you can
check the error log on the control pan-
el.

Limitation
❒ The error log displays only the 20

most recent entries. If the power is
turned off, the log is deleted.

AAAA Press the {{{{Printer}}}} key to display
the Printer screen.

BBBB Press [Error Log].

CCCC Press [Sample Print Job List].

DDDD Press [Details].

An error log list appears.

Note
❒ Press [UUUUPrev.] or [TTTTNext.] to

scroll through the error files.
❒ Press [Exit] after checking the

log.
❒ To print files that appear in the

error log, resend them after
stored files have been printed or
deleted.
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Locked Print

Use this function to maintain privacy
when printing confidential docu-
ments on the machine over a shared
network. Usually, it is possible to
print data using the display panel
once it is stored in this machine.
When using Locked Print, it is not
possible to print unless a password is
entered on the machine's display pan-
el. Your confidential documents will
be safe from being viewed by other
people.

Note
❒ Depending on the security set-

tings, certain print jobs may not be
displayed.

❒ If the application has a collate op-
tion, make sure it is not selected
before sending a print job. Locked
print jobs are automatically collat-
ed by the printer driver as default.
If a collate option is selected in the
application print dialog box, more
sets than intended may be printed.

❒ You can identify the file you want
to print by User ID, and date and
time when the job was stored.

❒ The number of pages the machine
can save depends on print image
content. For example, the machine
can save up to 30 jobs or 2,000 pag-
es including sample print files, de-
pending on data volume.

❒ After the locked print file is print-
ed, the job is automatically deleted.

❒ Turning off the machine's main
power switch deletes locked print
files.

❒ When user authentification is set,
user codes cannot be used to access
locked print files.

Printing a Locked Print File

The following procedure describes
how to print a locked print file with
the PCL 6/5e and the RPCS printer
driver. For information about how to
print a locked print file with the Post-
Script 3 printer driver, see PostScript 3
Supplement included as a PDF file on
the CD-ROM.

Limitation
❒ Applications with their own driv-

ers, such as PageMaker, do not
support this function.

❒ If you are using Mac OS X, this
function cannot be used.

AAAA Configure the locked print in the
printer driver's properties.

Reference
For details about configuring
the printer drivers, see the cor-
responding Help files.

BBBB Start printing from the applica-
tion's [Print] dialog box.

The locked print job is sent to the
machine.

CCCC On the machine's control panel,
press the {{{{Printer}}}} key to display
the Printer screen.

DDDD Press [Locked & Sample Print Job
List].

A list of the print files stored in the
machine appears.
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EEEE Press [Locked Print Job List].

A list of stored locked print files
appears.

The following items also appear:
• User ID:  The user ID set up by

the printer driver.
• Date / Time:  The date and time

when the job was sent from the
computer.

FFFF Select the file you want to print
by pressing it.

Note
❒ Press [UUUUPrev.] or [TTTTNext.] to

scroll through the list.
❒ Only one file can be selected at a

time.

GGGG Press [Print].

The password screen appears.

HHHH Enter the password using the
number keys, and then press [OK].

The print confirmation screen ap-
pears.

Note
❒ A confirmation screen will ap-

pear if the password is not en-
tered correctly. Press [OK] to
enter the password again.

IIII Press [Yes].

The locked file is printed.

Note
❒ Press [No] to cancel printing.
❒ To cancel printing, press [Exit].

After that, press [Job Reset]. Af-
ter it has started, the file will be
deleted.

Deleting Locked Print Files

AAAA Press the {{{{Printer}}}} key to display
the Printer screen.

BBBB Press [Locked & Sample Print Job
List].

A list of the print files stored in the
machine appears.

CCCC Press [Locked Print Job List].

A list of the locked print files
stored appears.

DDDD Select the file you want to delete
by pressing it.

Note
❒ Press [UUUUPrev.] or [TTTTNext.] to

scroll through the list.
❒ Only one file can be selected at a

time.

EEEE Press [Delete].

The password screen is displayed.
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FFFF Enter the password using the
number keys, and then press [OK].
The delete confirmation screen ap-
pears.

Note
❒ A confirmation screen will ap-

pear if the password is not en-
tered correctly. Press [OK] to
enter the password again.

GGGG Press [Yes].

After the file has been deleted, the
file list screen returns.

Note
❒ If you do not want to delete the

file, press [No].
❒ If you forget your password, se-

lect [Unlock] from [> Temporarily
Unlock Files] in [Password Manage-
ment for Stored Files] on the [Ad-
ministrator Tools]  tab of the
System Settings screen. With
this sett ing,  the password
screen is not displayed in the
procedure above. For more in-
formation about [Display Pass-
word with Stored File], see General
Settings Guide.

Checking the Error Log

If a file could not be stored in this ma-
chine, you can check the error log on
the display panel.

Limitation
❒ The error log displays only the 20

most recent entries. If the power is
turned off, the log will be deleted.

AAAA Press the {{{{Printer}}}} key to display
the Printer screen.

BBBB Press [Error Log].

CCCC Select [Locked Print Job List].

DDDD Press [Details].
An error log list appears.

Note
❒ Press [UUUUPrev.] or [TTTTNext.] to

scroll through the error files.
❒ Press [Exit] after checking the

log.
❒ To print files that appear in the

error log, resend them after
stored files have been printed or
deleted.
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Collate

When printing multiple documents such as handouts for meetings, you can sep-
arate sets into order. This function is known as “Collate”. Collate stores data
transmitted from a computer in memory. The following are the three types of
collate:

❖❖❖❖ Collate
Printed output is assembled as sets in sequential order.

❖❖❖❖ Rotating Collate
Every other print set is rotated by 90 degrees K.

❖❖❖❖ Shift Collate
(The optional finisher is required for this function.)
The finisher shift tray moves backward or forward when a job or set is output,
causing the next to shift, so you can separate them.

Limitation
❒ The optional finisher is required for Shift Collate.
❒ Rotating Collate is not possible when feeding paper from the bypass tray.
❒ Shift Collate is not possible when printing on 81/2” × 51/2”L.
❒ If jobs containing pages of various sizes are set, Rotating Collate will not

work.
❒ Rotating Collate, staple, punch and Z-fold functions cannot be combined.

2
1

3 2
1

3 2
1

3 2
1

3

GPSY013E

2
1

3 2
1

3 2
1

32
1

3

GPSY014E

2
1

3

32
1

32
1

32
1

GPSY015E
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Note
❒ You can set Collate in the RPCS printer driver.

• If you cannot make Shift Collate even with the optional finisher installed,
options may not be set up correctly in the printer driver. Correct the printer
driver's option settings. For details, see the printer driver Help.

❒ If Auto Continue occurs on the first set, Collate will be canceled.
❒ If forced printing occurs on the first set, Collate will be canceled.
❒ If a document with mixed paper sizes or sizes larger than A4, 81/2 “× 11” is

set, it can only be collated, even if Rotating Collate has been selected.
❒ When Cover/Slip Sheet has been selected, Collate or Shift Collate will occur

even if Rotating Collate has been selected.
❒ When Rotating Collate has been selected, printing speed will be slower than

with other collate functions.
❒ When setting Collate in the printer driver settings, make sure that a collate

option is not selected in the application's print settings. If a collate option is
selected, printing will not be as intended.

❒ The Rotating Collate function requires two paper trays containing same size
paper but in different orientations.

Reference
For information about paper sizes and the number of sets you can use Collate,
Rotating Collate, and Shift Collate with in every option, see Copy Reference.
For printing methods, see the printer driver Help.
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Printing with the Finisher

You can collate, staple or punch holes in printed paper by installing the optional
finisher. Make sure you read the following precautions when using the optional
finisher:

Reference
For information about optional finishers, see General Settings Guide.
To use the staple function, see p.91 “Staple”.
To use the punch function, see p.93 “Punch”.
To use the Z-fold function, see p.95 “Z-fold”.

❖❖❖❖ Be sure to make settings for options installed on the machine in the printer drivers.

Reference
To make settings for options in the printer drivers, see p.59 “Making Op-
tion Settings for the Printer”.

❖❖❖❖ Be sure to set the paper size and paper orientation in the printer driver when using
duplex printing, booklet, combine (layout), staple and punch functions.

Reference
For information about duplex printing, booklet, and layout, see the printer
driver Help.
To use the staple function, see p.91 “Staple” and the printer driver Help.
To use the punch function, see p.93 “Punch” and the printer driver Help.
To use the Z-fold function, see p.95 “Z-fold” and the printer driver Help.

Note
❒ Depending on the application, print settings may not be enabled and printed

output may not be as expected.

❖❖❖❖ When setting staple or collate in the printer driver, make sure that the Collate check
box is cleared in the application's [Print] dialog box.
If Collate is enabled in the application, printing will not be as intended.
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Staple

With the optional finisher installed, sets can be stapled individually when print-
ing multiple sets.

Staple Position

The specified staple position varies depending on paper size, type, quantity and
feed orientation. The following table shows staple positions:

Reference
• For paper sizes and maximum numbers of sheets available for stapling, see

“Specifications”,  General Settings Guide.
• For printing methods, see the printer driver Help.
• The staple position will vary when using the PostScript 3 printer driver.

For more information, see the PostScript 3 printer driver Help.

Stapling Precautions

Limitation
❒ Stapling can be done only with the optional finisher installed.
❒ Stapling cannot be done when paper is fed from the bypass tray.

Paper Orientation
on the Machine

Print Data 
Direction

Staple Position

Vertical

Vertical

Horizontal

Horizontal

Finisher 3000M / 3000B Booklet Finisher

AEW007S
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❒ You cannot interrupt the current job with a job for another function requiring
stapling or collating.

❒ When printing on letterhead, stapling may not be at the specified position.

Note
❒ When the finisher is installed, and when an output tray that cannot output us-

ing the staple function has been selected, the paper will be output according
to System Settings.

❒ If you cannot make staple settings even with the finisher installed, options
may not be set correctly in the printer driver. Correct option settings in the
printer driver. For details, see the printer driver Help.

❒ When duplex printing is selected, adjust staple positions to the binding orien-
tation.

❒ When the finisher is being used for another function's job (for example, a copy
job), printing will start after that job ends.

❒ When [Top left slant] or [Top right slant] is selected, the machine tries to staple
at an angle. However, if slanted staple is mechanically impossible, the ma-
chine staples horizontally or vertically.

❒ When setting Staple in the printer driver settings, make sure that a collate op-
tion is not selected in the print settings of the application. If a collate option is
selected in the application, printing will not be as intended.

❒ Be sure to set paper size and orientation in the printer driver when stapling.
• Depending on the software you are using, print settings may not be saved

and the printed result may not be as expected.
❒ When printing restarts after removing jammed paper, the printing position

may be different, depending on the location of the jam.
• If the paper jam occurred in the optional finisher, printing will restart from

the top page of the data currently being printed, or from the page where
the paper jam occurred.

• If the paper jam occurred in the machine, printing will restart from the
page where the paper jam occurred.

❒ Even if the paper jam occurred in the machine, the error will not be cleared
unless the cover of the finisher is opened and closed.

❒ Staple printing will be canceled under the following conditions:
• If the number of staple jobs exceeds maximum. For information about the

maximum number, see “Specifications”, General Settings Guide.
• If a paper size that cannot be stapled is selected. For information about pa-

per sizes that can be stapled, see “Specifications”, General Settings Guide.
• If positions other than those fixed for stapling are specified.
• If there are inconsistencies between the orientation in duplex mode and the

staple position.
• If paper sizes are mixed when a different paper size is specified during a

print job.
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• When staples have run out.
• When feeding paper from the bypass tray.
• When staples have run out and Auto Continue is set, printing will continue

without stapling after the message has been displayed.

Punch

With the optional finisher installed, holes can be punched into printed output.

Punch Position

The specified punch position varies depending on paper feed and print data ori-
entation. The following table shows punch positions:

Note
❒ Punch positions will vary slightly from page to page as holes are punched

into each sheet individually.

Reference
For information about paper sizes that can be punched, see “Specifications”,
General Settings Guide.
For printing methods, see the printer driver Help.
The punch position will vary when using the PostScript 3 printer driver. For
details, see the PostScript 3 printer driver Help.

Paper Orientation 
on the Machine

Print Data
Direction

Punch Position

Vertical

Vertical

Horizontal

Horizontal

2 holes 3 holes 4 holes

AEW008S
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Punching Precautions

Limitation
❒ Punching cannot be done when paper is fed from the bypass tray.

Note
❒ If you cannot make punch settings even with the finisher installed, options

may not be set correctly in the printer driver. Correct option settings in the
printer driver. For details, see the printer driver Help.

❒ When duplex printing is selected, adjust punch positions according to bind-
ing orientation.

❒ Be sure to set the punch position the same as the staple position when using
it with the staple function.

❒ Be sure to set paper size and orientation in the printer driver when punching.
• Depending on the software you are using, print settings may not be ena-

bled and the printed result may not be as expected.
❒ Punch will be canceled under the following conditions:

• When a paper size that cannot be punched is selected. For information
about paper sizes that can be punched, see “Specifications”, General Set-
tings Guide.

• If positions other than those fixed for punching are specified.
• If there are inconsistencies between the orientation in duplex mode and the

punch position.
• When feeding paper from the bypass tray.
• When the punch receptacle has become full and Auto Continue is set,

printing will continue without punching after the message appears.
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Z-fold

You can Z-fold prints when the optional Z-folding unit and the optional Booklet
Finisher are attached.

Folding Positions

When Z-folding, select the folding positions for the front page using the printer
driver.
The relationship between the size of the front page and that of subsequent pages
determines whether the subsequent pages can be Z-folded.

*1 Select the folding position according to the print direction.
*2 If the size of the paper is the same as that of the front page, the paper can be Z-folded

only if the front page can be Z-folded.

AEW009S

AC

A
C

CA

A
B
C

A
B
C

A
B
C

ABC ABC

Folding position*1

Right fold Z-fold not possible

Z-fold possible

Z-fold not possible

Z-fold possible

Z-fold not possible

Z-fold possible

Bottom fold

Left fold

Right fold

Bottom fold

Left fold

ResultPrint direction

Feed
direction

Front page

AEW010S

Paper size

Subsequent pages

Larger than front page

Smaller than front page

Z-fold possible

Z-fold not possible

Result*2
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Notes on the Z-fold Function

Limitation
❒ You can Z-fold with A3, A4, B4, 11"×17", 8 1/2"×11", and 8 1/2"×14" paper.
❒ When using the PostScript 3 printer driver, right or left Z-folding cannot be

performed if the size of the front page is A3, B4, 11"×17", or Legal.
❒ Z-folded paper can be stapled.
❒ When stapling Z-folded paper, fewer sheets than normal can be stapled together.

This is because a single Z-folded sheet is equivalent to 10 non-Z-folded sheets.
❒ Tray 1 of the optional Booklet Finisher cannot be selected to receive the deliv-

ered paper.
❒ The Z-fold function and punch function cannot be used together. If the Z-fold

function is used, punch function settings are canceled.
❒ You cannot Z-fold in the following cases:

• When the Z-fold function is not supported for the selected paper type
The Z-fold function is not supported for OHP transparencies, labels, thick
paper, translucent paper, and tab stock paper.

• When form feeding is used
• When the paper is fed from the optional interposer tray
• The rotating collate and auto tray switching cannot be used when Z-folding.

The output has the following appearance:

*1 When printing in landscape orientation with the PostScript 3 printer driver, you can-
not Z-fold in the specified positions. To Z-fold, print in portrait orientation and select
bottom fold.

AEW011S
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C

A B C

A B CABC

ABC ABC
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A
B

C

A
B
C

R
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R
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R
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R

R
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RAC
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AC

AC AC
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B
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AC
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C

CA

CA CA

A C

CA

A C

CA

*1 *1

*1*1

Left foldRight fold Bottom fold

A4 A4

A4 A4

A4 A3

A4 A3

A4 A5

A4 A5

Front page, Subsequent pages
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Spool Printing

Spool Printing allows print jobs transferred from a computer to be temporarily
stored, and then prints them after they are transferred. This shortens printing
time as it maximizes printer efficiency.

Important
❒ During Spool Printing, the hard disk is accessed and the Data-In indicator

blinks. Turning off the computer or machine during Spool Printing can dam-
age the hard disk. Also, if the computer or machine is turned off during Spool
Printing, spooled jobs will be deleted. Therefore, do not turn the power to the
computer or machine off during Spool Printing.

Limitation
❒ If data is sent to the machine using other protocols besides diprint, lpr, ipp,

and smb , Spool Printing cannot be performed.
❒ Up to a maximum of 150 jobs at once can be spool printed.

Note
❒ Printing the first page with Spool Printing will be slow.
❒ The computer requires less print processing time when large amounts of data

are spooled.
❒ Stored spool jobs can be viewed or deleted using a Web browser.

----Viewing/Deleting spool jobs in a Web browser
Start the Web browser and enter the machine's IP address in the address bar.
This displays the top page.
For more information, see Network Guide.

----Setting Spool Printing
Spool Printing can be set using telnet or a Web browser.
• Using a Web browser

See Network Guide or Help for more information.
• Using telnet

Type in “spoolsw spool on” to set Spool Printing.
See Network Guide for more information about telnet.
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Covers

Using this function, you can insert cover and back sheets fed from a different
tray to that of the main paper, and print on them.

Reference
For printing methods, see the printer driver Help.

Limitation
❒ To use this function, Collate must be set. Rotating Collate cannot be set.

Note
❒ The cover sheets should be the same size and orientation as the body of the

paper.
❒ If "Auto Tray Select" is set as the paper feed tray for the body paper, the paper

will be delivered from a tray containing paper in the K orientation. There-
fore, if the cover paper is set to L orientation, the orientation of cover and
body will be different.

❒ The cover sheets will not be printed when the sheet for the cover page is fed
from the optional interposer.
• For information about setting paper when using the optional interposer,

see “Loading Paper in the Interposer”, General Settings Guide.

❖❖❖❖ Cover Sheet
Prints the first page of the document on the sheet for the cover page.
• Print on one side

Prints on one side of the cover sheet only, even when duplex printing is se-
lected.

• Print on both sides
Prints on both sides of the cover sheet when duplex printing is selected.
• Front cover printed on both sides

GCPY016E

4 4

GCPY030E

2

1
3

4

1
2

3
4
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• Front cover printed on one side

• Blank
• When printing one side

• When printing both sides

❖❖❖❖ Front/Back covers
Prints the first and last page of the document as the cover and back cover pages.
• Print on one side

Prints on one side of the cover sheets only, even when duplex printing is
selected.
• Back cover page face inside

• Back cover page face outside

GCPY032E

3

4

1 1
2

2

3
4

GCPY017E

4 4

GCPY033E

3

4

1

1

2
23

4

GCPY018E

1 2 3
4 5

6

1
2 3

4 5
6

6

GCPY034E

1 2 3
4 5

6

1
2 3

4 5
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• Print on both sides
Prints on both sides of the cover sheets when duplex printing is selected.
• Front cover printed on both sides, back cover page face inside, and the

number of pages is even

• Front cover printed on both sides, back cover page face inside, and the
number of pages is odd

• Front cover printed on one side, back cover page face inside, and the
number of pages is even

• Front cover printed on one side, back cover page face inside, and the
number of pages is odd

GCPY031E

2

1
3

4

1 2 3
4 5

6

5

6

GCPY035E
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1 2 3
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• Blank
• When printing one side

• When printing both sides

GCPY023E

1 2 3
4 5

6

1 2 3
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Slip Sheets

❖❖❖❖ Inserting a slip sheet between each page
• Print

• Blank

❖❖❖❖ Inserting a slip sheet between OHP transparencies
• Print

• Blank

Note
❒ Collate cannot be set when using slip sheets.
❒ Slip sheets cannot be inserted while duplex printing.

GPAY019E

GPAY020E

222121 11
GCPY021E

2221 11
GCPY022E
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❒ The slip sheet should be the same size and orientation as the main paper.
❒ If “Auto Tray Select” has been set as the paper feed tray for the body paper,

the paper will be delivered from a tray containing paper in K orientation.
Therefore, when the cover paper has been set to L orientation, the orienta-
tion of the output cover paper and body paper will be different.

❒ Slip sheets cannot be printed when paper for the slip sheet is fed from the op-
tional interposer.
• For information about setting paper when using the optional interposer,

see “Loading Paper in the Interposer”, General Settings Guide.
❒ The same paper feed tray cannot be set for the main paper and slip sheets.
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Chaptering

The specified page is printed on the same side as the first page, like a book. Also,
you can insert chapter slip sheets before specified pages, and select whether or
not to print on the slip sheets.

Reference
For printing methods, see the printer driver Help.

Note
❒ Up to 20 pages can be specified as the front pages of chapters using the printer

driver.

❖❖❖❖ No slip sheets

Note
❒ This function is only valid with duplex printing.
❒ This function can be used together with combine (layout) printing.

❖❖❖❖ Inserting chapter slip sheets
• Print

Prints on the chapter slip sheets. When duplex printing is selected, both
sides of the slip sheets are printed on.

7

6

5

44

1

2

1 3

GCPY024E
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• Print on front side only
Prints on the front side of the chapter slip sheets even if duplex printing is
selected.

• Blank

Note
❒ The slip sheet should be the same size and orientation as the body of the

paper.
❒ If “Auto Tray Select” has been set as the paper feed tray for the body paper,

the paper will be delivered from a tray containing paper in K orientation.
Therefore, when the cover paper has been set to L orientation, the orien-
tation of the output cover paper and body paper will be different.

❒ The same paper feed tray cannot be set for the body of the document and
the slip sheet.

❒ Slip sheets cannot be printed on when paper is fed from the optional inter-
poser.
• For information about setting paper when using the optional interposer,

see “Loading Paper in the Interposer”, General Settings Guide.

GCPY032E

3

4

1 1
2

2

3
4

GCPY027E

MartiniC25-EN-Pref-F5_FM.book  Page 105  Thursday, December 9, 2004  10:59 AM



Other Print Operations

106

4

Tab Sheet

Prints on tab sheets.

Important
❒ Make sure to install the optional tab sheet holder when setting tab sheets.

Contact your service representative regarding the optional tab sheet holder
installation.

Limitation
❒ Only tab sheets with the tab on the right (at the top part of the paper) can be

printed on.

Reference
For information about tab sheets size that can be printed, see the General Set-
tings Guide.
For printing method, see the printer driver Help.

Note
❒ Make sure to check the position of the tab beforehand, so that images to be

printed do not come out slanted. If there are any letters in a position where
the tab is not present, toner may dirty the back of the paper.

❒ If there are any inconsistencies between the position of the tab, the staple and
the punch hole, the tab position will be prioritized.

GCPY025E
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User Defined Pages

Using this function, you can specify the page numbers for each input tray.

Reference
For printing methods, see the printer driver Help.

Limitation
❒ This function is available with the PCL 6/5e printer driver only.
❒ If [Document Server] is selected under [Job Type:], User Defined Page cannot be

used.
❒ If [User Defined Pages] is selected under [Paper Selection:] on [Paper] tab, [Lay-

out:] cannot be selected.
❒ If [User Defined Pages] is selected under [Paper Selection:] on [Paper] tab, [Book-

let] under [Duplex:] cannot be selected.

GCPY500E
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Form Feed

This section gives instructions for op-
erating the machine when there is no
tray for the selected paper size or
type, or when paper loaded in the
machine has run out.

Limitation
❒ The tray cannot be changed if the

following functions are set for it:
• Staple
• Punch
• Duplex Print to a tray that does

not support duplex printing
• Cover Sheet
• Front/Back Covers
• Slip Sheet
• Z-fold

Note
❒ If form feed is selected for a tray

with the following settings, you
can change the tray by canceling
the settings:
• Staple
• Punch
• Z-fold

❒ If Auto Continue is selected, form
fed paper is printed after a set in-
terval. See p.116 “System”.

If the machine does not have a tray for
the selected paper size or paper type,
or if the selected paper loaded in the
machine has run out, a caution mes-
sage appears.
If this message appears, do one of the
following:

Print Using a Selected Tray

AAAA Select the tray for form feed from
those that appear on the display
panel.

If you want to print after adding
paper to the tray, select the tray af-
ter loading the correct paper.

Note
❒ To load paper in the bypass tray,

see p.14 “Setting Paper on the
Bypass Tray”.

BBBB Press [Continue].

The machine prints using the se-
lected tray.

Note
❒ If a tray with a smaller paper

size is selected, the print job
may be cut short, or other prob-
lems may occur.
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Canceling Form Feed

AAAA Press [Reset ].
Delete the stored print job, and
then cancel form feed.

BBBB Press [Reset Current Job] or [Reset
All Jobs].

• [Reset Current Job]: cancels the
print job currently being proc-
essed.

• [Reset All Jobs]: cancels all jobs
in the print queue.

• [Resume Printing]: resumes print-
ing jobs.

A confirmation message appears.

CCCC Press [Yes] to cancel the print job.

Note
❒ Press [No] to return to the previ-

ous display.

Important
❒ If the machine is shared by mul-

tiple computers, be careful not
to accidentally cancel someone
else's print job.

❒ Under Windows, If the machine
is connected to the computer us-
ing a parallel cable, sent print
jobs may be canceled if [Reset All
Jobs] is pressed while “Wait-
ing...” is on the display panel.
After the interval set in [I/O Time-
out] in Printer Features has
passed, the next print job can be
sent. A print job sent from a dif-
ferent client computer will not
be canceled in this case.

Note
❒ You cannot stop printing data

that has already been proc-
essed. For this reason, printing
may continue for a few pages
after you press [Job Reset].

❒ A print job containing a large
volume of data may take con-
siderable time to stop.

Reference
p.110 “Canceling a Print Job”
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Canceling a Print Job

Windows - Canceling a Print Job 

AAAA Double-click the printer icon on
the Windows taskbar.

A window appears, showing all
print jobs currently queued for
printing. Check the current status of
the job you want to cancel.

BBBB Select the name of the job you
want to cancel.

CCCC On the [Document] menu, click
[Cancel Printing].

Note
❒ In Windows XP, Windows Server

2003, and Windows NT 4.0, click
[cancel] on the [Document] menu.

❒ In Windows 95/98/Me/2000 or
Windows NT 4.0, you can also
open the print job queue window
by double-clicking the machine
icon in the [Printers] machine
window (the [Printers and Faxes]
window under Windows XP and
Windows Server 2003).

DDDD Press the {{{{Printer}}}} key on the ma-
chine's control panel.

EEEE Press [Job Reset] on the display panel.

FFFF Press [Reset Current Job] or [Reset All Jobs].

• [Reset Current Job]: cancels the print
job currently being processed.

• [Reset All Jobs]: cancels all jobs
in the print queue.

• [Resume Printing]: resumes print-
ing jobs.

A confirmation message appears.

GGGG Press [Yes] to cancel the print job.

Note
❒ Press [No] to return to the previ-

ous display.

Important
❒ If the machine is shared by mul-

tiple computers, be careful not
to accidentally cancel someone
else's print job.

❒ If the machine is connected to the
computer using a parallel cable,
sent print jobs may be canceled if
[Reset All Jobs] is pressed while
“Waiting...” is on the display
panel. After the interval set in [I/O
Timeout] in Printer Features has
passed, the next print job can be
sent. A print job sent from a dif-
ferent client computer will not be
canceled in this case.

Note
❒ You cannot stop printing data

that has already been processed.
For this reason, printing may
continue for a few pages after
you press [Job Reset].

❒ A print job containing a large
volume of data may take consid-
erable time to stop.
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5. Printer Features

Reference
For more information about copier features and system settings, see Copy Ref-
erence and General Settings Guide.

Printer Features Menu

There are seven menu items in the Printer Features menu:
• List / Test Print
• Maintenance
• System
• Host Interface
• PCL Menu
• PS Menu (optional)
• PDF Menu (optional)
You can select the functions in the following table:

 Menu  Default 

List / Test Print

See p.114 “List / Test 
Print”.

Multiple Lists

Config. Page

Error Log

Menu List

PCL Config. / Font Page

PS Config. / Font Page *1 

PDF Config. / Font Page *1 

Hex Dump 

Maintenance

See p.116 “Maintenance”.

Menu Protect 

List / Test Print Lock

System

See p.116 “System”.

Print Error Report

Auto Continue

Memory Overflow

Job Separation  *2 

Memory Usage

Duplex

Copies

Blank Page Print

Edge Smoothing
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*1 Appears when the PostScript 3 unit (optional) is installed.
*2 Appears when a finisher (optional) is installed or a finisher with an attached mailbox

(optional) is installed.
*3 Appears when a finisher (optional) is installed.

System

See p.116 “System”.

Toner Saving

Spool Image

Reserved Job Waiting Time

Printer Language

Sub Paper Size

Page Size

Letterhead Setting

Bypass Tray Setting Priority

Edge to Edge Print

Default Printer Language

Collate Type

Stapling Type *3 

Punch Type *3 

Host Interface

See p.120 “Host Inter-
face”.

I/O Buffer 

I/O Timeout

PCL Menu

See p.120 “PCL Menu”.

Orientation

Form Lines

Font Source

Font Number

Point Size

Font Pitch 

Symbol Set

Courier Font

Extend A4 Width

Append CR to LF

Resolution

PS Menu (optional)  *1 

See p.122 “PS Menu”.

Data Format

Resolution

PDF Menu

 (optional)  *1 

See p.122 “PDF Menu”.

Change PDF Password

PDF Group Password

Resolution

 Menu  Default 
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Adjusting Printer Features

Printer Features allows basic adjustment of operations when using the machine
as a printer.
Although factory default settings are suitable for most printing jobs, Printer Fea-
tures gives you access to a number of settings that control basic printer opera-
tions. Printer Features settings you make are retained even when you turn off
the machine.
For more information about copier features and system settings, see Copy Refer-
ence and General Settings Guide.

AAAA Press the {{{{User Tools/Counter}}}} key on the control panel.

BBBB Press [Printer Features].

CCCC Select the desired item by pressing the tab, and then change its settings.

Note
❒  [OK]: Press to make new settings and go back to previous menus.
❒  [Cancel]: Press to return to a previous menu without changing any setting.

DDDD After changing Printer Features settings, press [Exit] to return to the User
Tools / Counter menu.

Note
❒ You can also exit from the User Tools / Counter menu by pressing the {{{{Us-

er Tools/Counter}}}} key.
❒ Changes made to functions remain in effect even if the machine is turned

off.
❒ You can also exit from the Printer Features menu by pressing [Exit] in the

main menu.
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Printer Features Parameters

List / Test Print

❖❖❖❖ Multiple Lists
You can print all types of the list
such as an error log list.

❖❖❖❖ Config. Page
You can print the machine's cur-
rent configuration values.

Reference
p.114 “Printing the configura-
tion page”

❖❖❖❖ Error Log
You can print error logs listing all
the errors that occurred during
printing. Up to 30 errors for nor-
mal print jobs, and 50 errors for
Sample Print jobs only, or Locked
Print jobs only, can be printed. In
addition to error logs, records of
Auto Job Cancel and jobs canceled
manually from the control panel
can be printed.

❖❖❖❖ Menu List
You can print a Menu List showing
the machine's function menus.

❖❖❖❖ PCL Config. / Font Page
You can print the current configu-
ration of installed PCL fonts.

❖❖❖❖ PS Config. / Font Page
You can print the current configu-
ration of installed PostScript fonts.

Note
❒ This menu can be selected only

when the optional PostScript 3
unit is installed.

❖❖❖❖ PDF Config. / Font Page
You can print the current configu-
ration.

Note
❒ This menu can be selected only

when the optional PostScript 3
unit is installed.

❖❖❖❖ Hex Dump
You can print the Hex Dump.

Printing the configuration page

AAAA Press the {{{{User Tools/Counter}}}} key
on the control panel.

The User Tools / Counter menu
appears.

BBBB Press [Printer Features].

The Printer Features menu ap-
pears.

CCCC Press [Config. Page] on the [List /
Test Print] tab.
 The configuration page is printed.
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Interpreting the configuration page

System Reference

❖❖❖❖ Unit Number
Displays the serial number as-
signed to the board by its manufac-
turer.

❖❖❖❖ Total Memory
Displays the total amount of mem-
ory (SDRAM) installed on the
printer.

❖❖❖❖ Firmware Version
• Printer

Displays the version number of
the printer firmware.

• System
Displays the version number of
the system firmware.

• Engine
Displays the version number of
the printer engine.

• LCDC
Displays the version number of
the panel display.

• NIB
Displays the version number of
the Network interface.

❖❖❖❖ Controller Option
This item(s) appears when the con-
troller option(s) is installed.

❖❖❖❖ HDD: Font / Macro Download
Displays the capacity of the hard
disk drive.

❖❖❖❖ Printer Language
Displays the version number of the
printer driver language.

❖❖❖❖ Options
Displays the optional trays in-
stalled.

Paper Input

Displays the settings made under the
Paper Input menu.

System

Displays the settings made under the
System menu.

Reference
p.116 “System”

PCL Menu

Displays the settings you made under
PCL Menu.

Reference
p.120 “PCL Menu”

PS Menu

Displays the settings you made under
PS Menu.

Reference
p.122 “PS Menu”

PDF Menu

Displays the settings you made under
PDF Menu.

Reference
p.122 “PDF Menu”

Host Interface

Displays the settings you made under
the Host Interface menu.
When DHCP is active on the network,
the actual IP address, subnet mask
and gateway address appear in pa-
rentheses on the configuration page.

Reference
p.120 “Host Interface”
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Interface Information

Displays the interface information.

Maintenance

❖❖❖❖ Menu Protect
This procedure lets you protect
menu settings from accidental
change. It makes it impossible to
change menu settings with normal
procedures unless you perform the
required key operations. In a net-
work environment, only adminis-
trators can make changes to menu
settings.
• Level 1

You can protect “Maintenance”,
”System”, “Host Interface”,
“PCL Menu”, "PS Menu" and
"PDF Menu".

• Level 2
You can protect “Maintenance”,
”System”, “Host Interface”,
“PCL Menu”, "PS Menu", "PDF
Menu" and "Tray Paper Set-
tings" in System Settings.

• Off

Note
❒ Default: Level 2
❒ You can protect menu settings

using a Web browser.

❖❖❖❖ List / Test Print Lock
You can lock the [List / Test Print]
menu.
• Off
• On

Note
❒ Default: Off

System

❖❖❖❖ Print Error Report
Select this to have an error report
printed when a printer or memory
error occurs.
• On
• Off

Note
❒ Default: On

❖❖❖❖ Auto Continue
You can select this to enable Auto
Continue. When it is On, printing
continues after a system error oc-
curs.
• Off
• Immediate
• 1 minute
• 5 minutes
• 10 minutes
• 15 minutes

Note
❒ Default: Off

❖❖❖❖ Memory Overflow
Select this to have a memory over-
flow error report printed.
• Do not Print
• Error Information

Note
❒ Default: Do not Print

❖❖❖❖ Job Separation
You can enable Job Separation.
• On
• Off

Note
❒ Default: Off

❒ This menu appears only when a
finisher (optional) is installed.
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❖❖❖❖ Memory Usage
You can select the amount of mem-
ory used in Font Priority or Frame
Priority, according to paper size or
resolution.
• Font Priority

This setting uses memory for
registering fonts.

• Frame Priority
This setting uses frame memory
for high speed printing.

Note
❒ Default: Frame Priority

❖❖❖❖ Duplex
You can select to have print on
both sides of each page.
• Off
• Long Edge Bind
• Short Edge Bind

Note
❒ Default: Off 

❖❖❖❖ Copies
You can specify the number of
print sets. This setting is disabled if
the number of pages to print has
been specified with the printer
driver or another command.
• 1 to 999 by 1

Note
❒ Default: 1

❖❖❖❖ Blank Page Print
You can select whether or not to
print blank pages.
• On
• Off
Pages that match one of the follow-
ing conditions are identified as
blank.
• There are no images.
• There are images but they are

outside of the printable area.

• There are only blank characters.

Note
❒ Default: On

❒ The printer does not identify
pages with white-colored imag-
es as blank.

❖❖❖❖ Edge Smoothing
You can set this to enable Edge
Smoothing.
• On
• Off

Note
❒ Default: On

❒ If Toner Saving is set to On,
Edge Smoothing is ignored
even if it is set to On.

❖❖❖❖ Toner Saving
You can this to enable Toner Sav-
ing.
• On
• Off

Note
❒ Default: Off

❖❖❖❖ Spool Image
You can select to print spool imag-
es.
The print job transmitted from the
computer is temporarily stored on
the machine's hard disk as bitmap
images that can be printed when
transmission is complete.
If more than one print job is trans-
mitted, a spool image is printed for
each.
• Off
• On

Note
❒ Default: Off
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Important
❒ When printing spool images,

the hard disk is active and the
Data-In indicator will blink.
Turning off the computer or
machine while printing spool
images the hard disk. Do not
turn off the computer or ma-
chine while printing spool im-
ages.

❖❖❖❖ Reserved Job Waiting Time
Sets Reserved Job Waiting Time.
• Long Wait
• Medium Wait
• Short Wait
• In Reserved Job Order

Note
❒ Default: Short Wait

❒ Reserved Job Waiting Time is
available only when [Job Order]
is selected for [Print Priority] in
System Settings. For details
about the Print Priority settings,
see General Settings Guide.

❖❖❖❖ Printer Language
You can specify the printer lan-
guage.
• Auto
• PCL
• PS
• PDF

Note
❒ Default: Auto

❖❖❖❖ Sub Paper Size
You can enable the Auto Substitute
Paper Size (A4↔LT) feature.
• Auto
• Off

Note
❒ Default: Off

❖❖❖❖ Page Size
You can select the default paper
size.
• 11 × 17
• 81/2× 14
• 81/2× 11
• 51/2 × 81/2

• 71/4×101/2

• 8×13
• 81/2×13
• 81/4×13
• A3
• B4 JIS
• A4
• B5 JIS
• A5
• A6
• 8K
• 16K
• Custom Size

Note
❒ Default:

• Metric version: A4K
• Inch version: 8/ × 11K

❖❖❖❖ Letterhead Setting
You can rotate original images
when printing.
When printing, original images are
always rotated by 180 degrees.
Therefore, output might not be as
expected when printing onto let-
terhead or preprinted paper re-
quiring orientation. Using this
function, you can specify image ro-
tation.
• Off 
• Auto Detect
• On (Always)
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Note
❒ Default: Off

❒ When set to Off, original images
are rotated by 180 degrees.

❒ When set to Auto Detectt, the
machine detects a letterhead or
preprinted paper automatically,
and does not rotate them.

❒ When set to On (Always), the
machine does not rotate.

❒ This function reduces printing
speed.

❖❖❖❖ Bypass Tray Setting Priority
You can specify which of the two
options, (Printer) Driver / Com-
mand or Machine Settings, has pri-
ority for determining the paper
size for the bypass tray.
• Driver / Command
• Machine Settings

Note
❒ Default: Driver / Command

❖❖❖❖ Edge to Edge Print
You can select whether or not to
print on the entire sheet.
• Off
• On

Note
❒ Default: Off
❒ The 5 mm margin along the

edges may not be printed prop-
erly.

❖❖❖❖ Default Printer Language
You can set the default printer lan-
guage if the machine cannot find
the printer language automatical-
ly.
• PCL
• PS
• PDF

Note
❒ Default: PCL

❒ PS and PDF appears only when
the optional PostScript 3 unit is
installed.

❖❖❖❖ Collate Type
You can set the default collate type
if the machine cannot find the
printer language automatically.
• Collate
• Rotating Collate
• Shift Collate

Note
❒ Default: Collate

Reference
For details, see p.88 “Collate”.

❖❖❖❖ Stapling Type
You can set the default staple type
if the machine cannot find the
printer language automatically.
• Off
• Top Left Slant
• Top Right Slant
• Left 2
• Top 2
• Right 2
• Top Left
• Top Right
• Center

Note
❒ Default: Off

❒ This menu appears only when a
finisher (optional) is installed.

Reference
For details, see p.91 “Staple”.
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❖❖❖❖ Punch Type
You can set the default punch type
if the machine cannot find the
printer language automatically.
• Off
• Left 2
• Top 2
• Right 2
• Left 3
• Top 3
• Right 3
• Left 4
• Top 4
• Right 4

Note
❒ Default: Off
❒ This menu appears only when

the optional punch is installed.
❒ Displayed items will differ de-

pending on the finisher type,
the original's orientation, the
paper size, and the orientation
type.

Reference
For details, see p.93 “Punch”.

Host Interface

❖❖❖❖ I/O Buffer
You can set the size of the I/O
Buffer. Normally it is not neces-
sary to change this setting.
• 128 KB
• 256 KB
• 1 MB

Note
❒ Default: 128 KB 

❖❖❖❖ I/O Timeout
You can set how many seconds the
machine should wait before end-
ing a print job. If data from another
port usually arrives in the middle
of a print job, you should increase
this timeout period.
• 10 seconds
• 15 seconds
• 20 seconds
• 25 seconds
• 60 seconds

Note
❒ Default: 15 seconds

PCL Menu

❖❖❖❖ Orientation
You can set the page orientation.
• Portrait
• Landscape

Note
❒ Default: Portrait

❖❖❖❖ Form Lines
You can set the number of lines per
page.
• 5 to 128 by 1

Note
❒ Default: 

• Metric version: 64
• Inch version: 60

❖❖❖❖ Font Source
You can set the storage location of
the default font.
• Resident
• RAM
• HDD
• SD
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Note
❒ Default: Residentt

❒ RAM, HDD and SD can be se-
lected only when fonts have
been downloaded to the ma-
chine.

❖❖❖❖ Font Number
You can set the ID of the default
font you want to use.
• 0 to 50 by 1

Note
❒ Default: 0

❖❖❖❖ Point Size
You can set the point size you want
to use for the selected font.
• 4.00 to 999.75 by 0.25

Note
❒ Default: 12.00
❒ This setting is effective only

with variable-space fonts.

❖❖❖❖ Font Pitch
You can set the number of charac-
ters per inch for the selected font.
• 0.44 to 99.99 by 0.01

Note
❒ Default: 10.00
❒ This setting is effective only

with fixed-space fonts.

❖❖❖❖ Symbol Set
You can specify the set of print
characters for the selected font.
The available options are as fol-
lows:
Roman-8, ISO L1, ISO L2, ISO L5,
PC-8, PC-8 D/N, PC-850, PC-852,
PC8-TK, Win L1, Win L2, Win L5,
Desktop, PS Text, VN Intl, VN US,
MS Publ, Math-8, PS Math, VN
Math, Pifont, Legal, ISO 4, ISO 6,
ISO 11, ISO 15, ISO 17, ISO 21, ISO
60, ISO 69, Win 3.0

Note
❒ Default: PC-8 

❖❖❖❖ Courier Font
You can select a courier font type.
• Regular
• Dark

Note
❒ Default: Regular

❖❖❖❖ Extend A4 Width
You can extend the printing area
width (when printing on A4 sheet
with PCL).
• Off
• On

Note
❒ Default: Off

❒ When the setting is On, the
width will be 8/ inches.

❖❖❖❖ Append CR to LF
When set to On, a carriage return
will follow each line feed: CR=CR,
LF=CR−LF, FF=CR−FF.
• Off
• On

Note
❒ Default: Off

❖❖❖❖ Resolution
You can set the print resolution in
dots per inch.
• 300 dpi
• 600 dpi

Note
❒ Default: 600 dpi
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PS Menu

This menu appears only when the op-
tional PostScript 3 unit is installed.

❖❖❖❖ Data Format
You can select a data format.
• Binary Data
• TBCP

Limitation
❒ This setting is not effective

when operating the machine
w i t h  a  p a r a l l e l ,  U S B ,  o r
EtherTalk connection.

❒ When operating the machine
with a parallel or USB connec-
tion, if binary data is sent from
the printer driver, the print job
is canceled.

❒ When operating the machine
with an Ethernet connection,
the print job is canceled under
the following conditions;
• The printer driver data for-

mat is TBCP, and the data
format selected on the dis-
play panel is Binary Data.

• The printer driver data for-
mat is binary, and the data
format selected on the dis-
play panel is TBCP.

Note
❒ Default: Binary Data

❖❖❖❖ Resolution
You can set the print resolution in
dots per inch.
• 300 dpi
• 600 dpi
• 1200 dpi

Note
❒ Default: 600 dpi

PDF Menu

This menu appears only when the op-
tional PostScript 3 Unit is installed.

❖❖❖❖ Change PDF Password
Set [Password to Open the Text File] for the
PDF file executing PDF Direct Print.
• Current Password
• New Password
• Confirm New Password
A password can be set using on the
Web Image Monitor, but in this case
the password information is sent
through the network. If security is a
priority, set the password using this
menu from the Control Panel.

Note
❒ Default: Not Set

❖❖❖❖ PDF Group Password
Set the group password already
specified with DeskTopBinder Lite.
• Current Password
• New Password
• Confirm New Password
A password can be set using on the
Web Image Monitor, but in this case
the password information is sent
through the network. If security is a
priority, set the password using this
menu from the Control Panel.

Note
❒ Default: Not Set

❖❖❖❖ Resolution
You can select the resolution for
the PDF file executing PDF Direct
Print.
• 300 dpi
• 600 dpi
• 1200 dpi

Note
❒ Default: 600 dpi
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6. Using the Document Server

Accessing the Document Server

The Document Server enables you to store documents on the machine's hard
disk, allowing you to edit and print as and when you want.

Limitation
❒ Applications with their own drivers, such as PageMaker, do not support this

function.

Reference
For more information about Document Server functions, see  General Settings
Guide.
For information about how to access Document Server from a client, see the
printer driver Help.

Note
❒ When you use the Document Server, the following functions can be selected

using the machine's control panel:
• Copies
• Collate
• Duplex
• Staple
• Punch
• Z-fold
• Paper selection: Paper source tray, paper type, paper output tray.
• Functions related to paper selection: Cover sheets, slip sheets.

❒ The above items are dimmed, so you cannot set them from the printer prop-
erties dialog box when the Document Server is selected.

❒ You must enter a user ID, using up to eight alphanumeric characters.
❒ You should enter a Password and File Name to distinguish the job from oth-

ers.
❒ Up to 3,000 files can be stored in the Document Server. No new files can be

stored after 3,000 is reached. Even if less than 3,000 files are stored, new files
cannot be stored when
• a file to be stored contains more than 2,000 pages,
• the total number of pages contained in files stored exceeds 10,000,
• the hard disk is full.
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❒ The Document Server also stores files scanned using the Automatic Docu-
ment Feeder (ADF) or exposure glass. You should delete unnecessary stored
files once in a while so as not to exceed the capacity of the hard disk. For how
to delete stored files, see General Settings Guide.

❒ When using the hard disk for functions other than those of Document Server,
you may be unable to store new files in the Document Server, even if there are
less than 3,000 files stored.
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7. The Functions and Settings
of the Machine

Mainframe

Network Guide, PostScript 3 Supplement, and UNIX Supplement cover all mod-
els, and therefore contain all the functions and settings. This chapter describes
the functions and setting items used for configuring the model you are using.

Reference
For details about functions and setting items, see Network Guide, PostScript 3
Supplement and UNIX Supplement.

Functions

The following functions are available with the machine:
• Copy
• Printer
• Scanner
• Document Server

Note
❒ The machine must be equipped with the Printer/Scanner Unit in order to use

the printer or scanner function. 

Interface

The following interfaces are available with the machine:
• Ethernet (100BASE-TX / 10BASE-T)
• IEEE 802.11b (wireless LAN)
• IEEE 1394 (IP over 1394 / SCSI print)
• USB (2.0 / 1.1)
• IEEE 1284 (parallel)
• Bluetooth™

Note
❒ To use the IEEE 802.11b (wireless LAN) interface, the USB interface, or the

IEEE 1394 (IP over 1394) interface, the machine must be equipped with the
corresponding unit for that interface.

❒ You cannot install the IEEE 802.11b (wireless LAN) interface, the USB inter-
face, and the IEEE 1394 (IP over 1394) interface on the machine at the same
time.
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List of the Setting Items

Web Image Monitor

The following are the items of Web Image Monitor available with the machine:
R: Read 
W: Write
--: None

Menu Before logon After logon as 
Admin.

Top Page R R

Status Input Tray R R

Output Tray R R

Toner R R

Function R R

System R R

Counter R R

Printer Language R RW

Document Server R RW

Job Printer Spool Printing R RW

Job History R RW

Error Log R RW

Locked & Sam-
ple Print Job List

RW RW

Address Book -- RW

Inquiry R RW

Configuration Device Settings System R RW

Paper R RW

Timer Settings R RW

E-mail R RW

File Transfer -- RW

Program/Change 
Administrator

-- RW

User Authentica-
tion Management

-- RW

Administrator 
Authentication 
Management

-- RW
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telnet

The following telnet can be used with the machine:
access, appletalk, autonet, btconfig, dhcp, diprint, dns, domainname, help, host-
name, ifconfig, info, ipp, netware, passwd, prnlog, rendezvous, route, set, show,
slp, smb, snmp, spoolsw, sprint, status, syslog, web, wiconfig, wins

UNIX

The following UNIX commands can be used with the machine:

Configuration Printer R RW

Interface R R

Network Protocol R RW

TCP/IP R RW

NetWare R RW

AppleTalk R RW

SMB R RW

SNMP -- RW

SNMPv3 -- RW

Rendezvous R RW

System Log R R

Webpage RW RW

Security IPP Authentica-
tion

-- RW

IPP Authentica-
tion

-- RW

SSL/TLS -- RW

Certificates -- RW

Device Option Value Function Summary.

filetype pcl, postscript (rps) Specifies the printer language 
for printing.

filter text Specifies the text printing.

tray tray1~tray3, lct, bypass, all Specifies the input tray.

paper a3~a6, jisb4, jisb5, ledger, letter, 
halfletter, legal, executive, fgl, 
foolscap, folio, k8, k16, custom

Specifies the paper size.

Menu Before logon After logon as 
Admin.
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papertype plain, letterhead, labels, trans-
parency, recycled, usercolor1, 
usercolor2, special, thick, tab-
stock, translucent

Specifies the paper type.

outbin upper, finishershift, finisher-
proof, finisherbooklet, option-
aloutputbin X

Specifies the output tray.

copies Number of copies (1-999) Specifies the number of copies.

qty Number of collated sets (1-999) Specifies the number to collate.

duplex on, off Specifies whether duplex 
printing is on or off.

binding longedge, shortedge Specifies the binding direction 
for duplex printing.

orientation portrait, landscape Specifies the feed direction of 
the paper.

resolution value of resolution (1200, 600) Specifies the resolution for 
printing.

staple off, lefttop, righttop, left-
topslantport, lefttopslant-
land, lefttopvertport, 
lefttopvertland, left2port, 
left2land, right2port, 
right2land, righttopvertport, 
righttopvertland, right-
topslantport, righttopslant-
land, righttophorizport, 
righttophorizland, top2port, 
top2land, lefttophorizport, 
lefttophorizland, booklet

Specifies the staple position.

punch off, leftport, leftland, right-
port, rightland, topport, top-
land

Specifies the punch position.

punchhole jp2, us2, us3, eu4, neu4 Specifies the punch hole.

fold zbottom, zright, zleft Specify how to Z-fold prints.

symbol set desktop, iso4, iso6, iso11, 
iso15, iso17, iso21, iso60, 
iso69, isol1, isol2, isol5, legal, 
math8, mspubl, pc8, pc850, 
pc852, pc8dn, pc8tk, pifont, 
psmath, pstext, roman8, vn-
intl, vnmath, vnus, win30, 
winl1, winl2, winl5

Specify the set of print charac-
ters.

Device Option Value Function Summary.
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Settings that can be used with PostScript 3

The following PostScript 3 settings can be used with the machine:

Settings Selectable Items

Paper Size See General Setting Guide.

Fit to Paper

Input Slot

Bypass Tray Tray 1

Tray 2

Tray 3

Large Capacity Tray

Resolution 600dpi

1200dpi

Print Mode (Toner Saving)

Duplex

Collate

Paper Type See General Setting Guide.

Destination Printer Default

Copy Tray

Finisher Upper Tray

Finisher Shift Tray 1

Finisher Shift Tray 2

Mailbox Tray 1

Mailbox Tray 2-Mailbox Tray 9

Staple Off

Top left

Top right

Bottom left

Bottom right

2 at left

2 at right

2 at top

2 at bottom

2 at Center
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Punch Off

2 at left

3 at left

4 at left

2 at right

3 at right

4 at right

2 at top

3 at top

4 at top

2 at bottom

3 at bottom

4 at bottom

Z-fold Off

Bottom Fold

Right Fold

Left Fold

Dithering

Image Smoothing

Settings Selectable Items
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Software and Utilities Included on the CD-
ROM

Three CD-ROMs come with this printer: "Printer Drivers and Utilities", "Operat-
ing Instructions for Printer/Scanner", and "Scanner Driver & Document Man-
agement Utility". The following are included on the three separate CD-ROMs.

❖❖❖❖ Font Manager 2000
For installing new screen fonts, or organizing and managing fonts already in
the system. For details about Font Manager 2000, see the manual on the CD-
ROM labeled "Printer Drivers and Utilities".

❖❖❖❖ SmartDeviceMonitor for Admin
For the system administrator to manage network printers.

Reference
SmartDeviceMonitor for Admin Help

❖❖❖❖ SmartDeviceMonitor for Client
For users to manage their network print status.

Reference
SmartDeviceMonitor for Client Help

❖❖❖❖ 1394 Utility
For the optional IEEE 1394 interface unit. For details, see the Readme file or
the manual provided with the optional IEEE 1394 interface unit.

❖❖❖❖ USB Printing Support 
For connection to Windows 98 SE/Me computers via USB.

❖❖❖❖ Acrobat Reader
This utility allows you to read PDF files (Portable Document Format).

Note
❒ Documentation about using the machine is included on the CD-ROM in

PDF format. For details about using Acrobat Reader, see Acrobat Reader
online Help.

❖❖❖❖ Printer Utility for Mac
This utility allows users to download and manage a variety of fonts as well as
manage printers. For details about this utility, see Network Guide.
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Viewing the contents of the CD-ROM

Follow the procedure below to view the contents of the CD-ROM.

AAAA Insert the CD-ROM into the CD-ROM drive.

The installer starts.

BBBB Click [Browse This CD-ROM].

Explorer starts and displays the contents of the CD-ROM.

Printer Drivers for This Printer

Printing requires installing a printer driver appropriate to your operating system.
The following drivers are included on the CD-ROM provided with this machine.

*1 Microsoft Windows 95 operating system
*2 Microsoft Windows 98 operating system
*3 Microsoft Windows Millennium Edition
*4 Microsoft Windows 2000 Advanced Server

Microsoft Windows 2000 Server
Microsoft Windows 2000 Professional

*5 Microsoft Windows XP Professional
Microsoft Windows XP Home Edition

*6 Microsoft Windows Server 2003 Standard Edition
Microsoft Windows Server 2003 Enterprise Edition

*7 Microsoft Windows NT Server operating system version 4.0, Microsoft Windows NT
Workstation operating system version 4.0 in a computer using x86 processors.

*8 Versions 8.6 to 9.2 of the Mac OS (Mac OS X Classic mode is supported.)
*9 Mac OS X 10.1 or later (Native mode)
*10 Requires Service Pack 4 or later.
*11 Requires Service Pack 6 or later.
*12 The Adobe PostScript 3 printer drivers and PostScript Printer Description (PPD) files

are included on the CD-ROM labeled “Printer Drivers and Utilities”.
*13 The PostScript Printer Description (PPD) files are included on the CD-ROM labeled

“Printer Drivers and Utilities”.
*14 The Adobe PostScript Printer Description (PPD) installer is included on the CD-

ROM labeled “Printer Drivers and Utilities”.

Printer Language PCL 6 PCL 5e RPCS PostScript 3

Windows 95 *1 OK OK OK OK *12 

Windows 98 *2 OK OK OK OK *12 

Windows Me *3 OK OK OK OK *12 

Windows 2000 *4 OK OK OK OK *13 

Windows XP *5 OK OK OK OK *13 

Windows Server 2003 *6 OK OK OK OK *13 

Windows NT 4.0 *7 OK *11 OK *10 OK *10 OK *11  *12 

Mac OS *8 OK *12 

Mac OS X *9 OK *14 
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❖❖❖❖ PCL printer drivers
Two kinds of PCL printer drivers: PCL 6 and PCL 5e, are included on the CD-
ROM that comes with this machine. These drivers allow the computer to com-
municate with the machine via a printer language. We recommend PCL 6 as
your first choice.

Note
❒ Some applications may require installation of the PCL 5e printer driver. In

this case, you can install PCL 5e without having to install PCL 6.

Reference
See p.19 “Preparing the Machine”.

❖❖❖❖ RPCS printer driver
This printer driver allows the computer to communicate with the printer us-
ing a printer language. In addition to the conventional user interface, another
preset user interface is provided.

Reference
See p.19 “Preparing the Machine”.

❖❖❖❖ Adobe PostScript Printer Drivers and PPD files
Adobe PostScript printer drivers and the PPD files are included on the CD-
ROM provided with this machine. Adobe PostScript printer drivers allow the
computer to communicate with the printer using a printer language. PPD
files allow the printer driver to enable specific printer functions.

Reference
See PostScript 3 Supplement.

❖❖❖❖ PPD files
PPD files are included on the CD-ROM provided with this machine. PPD files
allow the printer driver to enable specific printer functions.

Reference
See PostScript 3 Supplement.
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SmartDeviceMonitor for Admin

SmartDeviceMonitor for Admin is an application that uses TCP/IP and IPX/SPX
to monitor network printers. It can monitor multiple network printers using IP ad-
dress We recommend that network administrators use this application

❖❖❖❖ File path
SmartDeviceMonitor for Admin is stored in the following folder on the CD-
ROM.
NETWORK\NETMON\admin\DISK1

❖❖❖❖ Available functions
SmartDeviceMonitor for Admin has the following functions to check:
• printer supplies such as paper or toner;
• results of print jobs executed from the computer.

Reference
For information about the operations of the system administrator, see Net-
work Guide.
For information about using SmartDeviceMonitor for Admin, see Smart-
DeviceMonitor for Admin Help.

Operating system Protocol stack

Windows 95/98/Me TCP/IP provided with Windows 95/98/Me

IPX/SPX provided with Windows 95/98/Me

NetWare Client provided with Windows 95/98

Novell Client provided with Windows 95/98

Windows 2000 TCP/IP provided with Windows 2000

IPX/SPX provided with Windows 2000

NetWare Client provided with Windows 2000

Novell Client provided with Windows 2000 or Win-
dow NT

Windows XP TCP/IP provided with Windows XP

IPX/SPX provided with Windows XP

NetWare Client provided with Windows XP

Novell Client provided with Windows XP

Windows Server 2003 TCP/IP provided with Windows Server 2003

IPX/SPX provided with Windows Server 2003

NetWare Client provided with Windows Server 2003

Novell Client provided with Windows Server 2003

Windows NT 4.0 TCP/IP provided with Windows NT

IPX/SPX provided with Windows NT

Client Service for NetWare provided with Windows NT

Novell Client provided with Windows 2000 or Win-
dows NT
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SmartDeviceMonitor for Client

SmartDeviceMonitor for Client has the following functions. We recommend that
users install this application.
• Printing in a peer-to-peer network, using TCP/IP, NetBEUI, and IPP from

Windows 95/98/Me/2000/XP, Windows Server 2003, and Windows NT 4.0.
• Constantly monitoring the status of devices on the network using TCP/IP

and IPX/SPX.

❖❖❖❖ File path
SmartDeviceMonitor for Client is stored in the following folder on the CD-ROM.
NETWORK\NETMON\CLIENT\DISK1

Operating system Protocol stack

Windows 95/98/Me TCP/IP provided with Windows 95/98/Me

IPX/SPX provided with Windows 95/98/Me

NetBEUI provided with Windows 95/98/Me

NetWare Client provided with Windows 95/98/Me

Novell Client provided with Windows 95/98/Me

Windows 2000 TCP/IP provided with Windows 2000

IPX/SPX provided with Windows 2000

NetBEUI provided with Windows 2000

NetWare Client provided with Windows 2000

Novell Client provided with Windows 2000 or NT

Windows XP TCP/IP provided with Windows XP

IPX/SPX provided with Windows XP

NetWare Client provided with Windows XP

Novell Client provided with Windows XP

Windows Server 2003 TCP/IP provided with Windows Server 2003

IPX/SPX provided with Windows Server 2003

NetWare Client provided with Windows Server 2003

Novell Client provided with Windows Server 2003

Windows NT 4.0 TCP/IP provided with Windows NT

IPX/SPX provided with Windows NT

NetBEUI provided with Windows NT

Client Service for NetWare provided with Windows NT

Novell Client provided with Windows 2000 or Win-
dows NT

MartiniC25-EN-Pref-F5_FM.book  Page 135  Thursday, December 9, 2004  10:59 AM



Appendix

136

8

❖❖❖❖ Available functions
SmartDeviceMonitor for Client has the following functions.
• Peer-to-peer print function

• Prints directly on the network printer without sending any data to a
print server.

• Prints on a substitute printer when there are too many jobs waiting on
the specified printer, or when an error disables printing (Recovery
Printing).

• Allocates multiple print jobs to multiple printers (Parallel Printing).
• Executes prior group registration of printers specified for Recovery

Printing or Parallel Printing.
• Notification function

• Displays an error message when there is an error on the specified print-
er while transferring or printing data.

• Notifies a print completion. You can also be notified of the print condi-
tion, such as displaying the notice only when Recovery Printing is exe-
cuted.

• Monitoring function
• Checks printer supplies such as paper or toner.
• Simultaneously monitors multiple printers in use.
• Checks the printer's network settings and detailed information of print-

ers.
• Enables you to check the print job log using the user ID

Limitation
❒ For Recovery Printing or Parallel Printing, the options on the printers must

be the same. If a necessary option is not installed, a printer cannot be used
for Recovery Printing or Parallel Printing.

❒ For Recovery Printing or Parallel Printing, the paper loaded in the printers
must be the same. When a tray is selected for printing, load the same paper
in that tray in all printers.

❒ For Recovery Printing or Parallel Printing, the print results may be differ-
ent if the printers are not the same model or have exactly the same options.

❒ If you select Sample Print or Locked Print, you cannot select Recovery
Printing or Parallel Printing.

Reference
SmartDeviceMonitor for Client Help
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Troubleshooting

Error & Status Messages on the Display Panel

This section describes the principal messages that appear on the panel display.
If a message not described here appears, act according to the message.

Reference
Before turning the main power off, see "Turning On the Power", General Set-
tings Guide.

❖❖❖❖ Status messages

❖❖❖❖ Alert messages

Message Status

Hex Dump Mode In Hex Dump mode, the machine receives data in hexadecimal 
format. Turn off the machine after printing, and then turn back on.

Offline The machine is offline. To start printing, switch the machine 
online by pressing [Offline] on the display panel.

Please wait. The machine is preparing the development unit. Wait a while.

Printing... The machine is printing. Wait a while.

Ready This is the default ready message. The machine is ready for 
use. No action is required.

Resetting job... The machine is resetting the print job. Wait until “Ready” ap-
pears on the display panel.

Setting change... The machine is setting changing. Wait a while.

Waiting... The machine is waiting for the next data to print. Wait a while.

Messages/Second messages Causes Solutions

Authentication has failed. The login user name or pass-
word entered is incorrect.

The machine currently cannot 
perform authentication.

Check your login user name 
and password.

Consult an administrator.

Cannot connect with the 
wireless card.

The IEEE 802.11b interface 
unit may have come off, or an 
error may have occurred in the 
IEEE 802.11b interface unit.

Turn off the main power 
switch, and check the IEEE 
802.11b interface unit is in-
stalled correctly. If the message 
appears again, contact your 
sales or service representative.

Collate has been cancelled. The collate print function has 
been canceled.

Turn off the main power 
switch, and back on again. If 
the message appears again, 
contact your sales or service 
representative.
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Selected files contain file(s) 
that the user does not have ac-
cess privileges to. Please note 
that only the files with access 
privileges will be deleted.

Documents for which you do 
not have the right to delete are 
selected.

A File Administrator can delete 
documents. If you want to de-
lete documents for which you 
do not have the right to delete, 
consult the administrator.

Driver setting error. (Memory) There is an error in the down-
loaded font(s).

Reset the parameter for down-
loading fonts.

Insufficient memory or memo-
ry settings for the printer driv-
er may not match memory 
actually installed.

Specify correct memory capac-
ity on the [Change Accesso-
ries...] tab in the RPCS printer 
driver.

To print the image correctly, 
increase memory capacity, or 
reduce resolution image.

Duplex has been cancelled. Duplex printing has been can-
celed.

Check the paper used is suita-
ble for duplex printing. Or, in-
crease memory capacity. 
When installing a memory 
module in the machine, con-
tact your sales or service rep-
resentative.

Ethernet board has a prob-
lem.

An error has occurred in the 
Ethernet board.

Turn off the main power 
switch, and back on again. If 
the message appears again, 
contact your sales or service 
representative.

Exceeded max. capacity of 
document server. Cannot 
store.

Hard disk drive capacity ex-
ceeded storing to the Docu-
ment Server.

Delete some files stored in the 
Document Server or decrease 
the file size to be downloaded.

Exceeded max. number of 
files of document server. Can-
not store.

The maximum number of files 
stored in the Document Server 
has been exceeded.

Delete some files stored in the 
Document Server.

Exceeded max. number of 
pages of document server. 
Cannot store.

The maximum number of pag-
es stored in the Document 
Server has been exceeded.

Delete some pages stored in 
the Document Server or de-
crease the number of pages to 
be downloaded.

Exceeded max. stored files in 
sample print and locked 
print.

The maximum number of 
stored files has been exceeded 
during Sample Print or 
Locked Print.

Delete some stored files or re-
duce file sizes.

Exceeded max. stored pages 
in sample print and locked 
print.

The maximum number of 
stored pages has been exceed-
ed during Sample Print or 
Locked Print.

Reduce the number of pages 
to be printed.

Messages/Second messages Causes Solutions
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Exceeded max. pages. Collate 
is incomplete.

The maximum number of pag-
es has been exceeded for colla-
tion.

Turn off the main power 
switch, and back on again. Re-
duce the number of pages to 
be printed. If the message ap-
pears again, contact your sales 
or service representative.

HDD has a problem. An error has occurred in the 
hard disk drive.

Turn off the main power 
switch, and back on again. If 
the message appears again, 
contact your sales or service 
representative.

Data storage error. Locked Print was performed 
without the hard disk installed, 
or the hard disk is damaged.

Contact your sales or service 
representative.

HDD is full. The maximum hard disk area 
size for form/font has been ex-
ceeded.

Delete unused form / font 
types.

An HDD overflow error oc-
curred during Sample Print or 
Locked Print.

Delete some stored files, or re-
duce the size of the file to be 
downloaded.

dLower staple is almost 
empty.

There are only a few staples 
left in the lower stapler.

Load more staples.

NV-RAM has a problem. An error has occurred in the 
NV-RAM.

Turn off the main power switch, 
and back on again. If the mes-
sage appears again, call your 
sales or service representative.

Output tray has been 
changed.

The output tray has been 
changed because of the paper 
size limitation of the selected 
tray.

Select the correct output tray.

Paper in staple tray. Open Fin-
isher Cover and remove paper.

There is paper remaining in-
side the finisher.

Open the cover of the finisher, 
and remove the paper.

Parallel I/F board has a prob-
lem.

An error has occurred in the 
parallel interface board.

Contact your sales or service 
representative.

Print overrun. The image data has been 
thinned out due to image com-
pression.

Increase memory capacity. 
When installing a memory 
module in the machine, con-
tact your sales or service rep-
resentative.

Problems with the wireless 
board.

An error may have occurred in 
the IEEE 802.11b interface unit.

Turn off the main power 
switch, and back on again. If 
the message appears again, 
contact your sales or service 
representative.

Problems with the wireless 
card.

An error may have occurred in 
the IEEE 802.11b interface unit.

Punch has been cancelled. Punch has been cancelled. Check the paper feed direc-
tion, paper orientation, and 
punch position.

Messages/Second messages Causes Solutions
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Staple has been cancelled. Staple printing has been can-
celed.

Check the paper feed direc-
tion, paper orientation and 
stapling position.

The print job has been can-
celled because capture file(s) 
could not be stored: Exceeded 
max. memory.

An HDD overflow error has 
occurred when storing cap-
ture file(s).

Delete some files stored in the 
Document Server or reduce 
the size of files to be printed.

The print job has been can-
celled because capture file(s) 
could not be stored: Exceeded 
max. number of files.

The maximum number of 
stored capture files has been 
exceeded.

Delete some files stored in the 
Document Server.

The print job has been can-
celled because capture file(s) 
could not be stored: Exceeded 
max. number of pages per file.

The maximum number of 
stored capture pages has been 
exceeded.

Delete some files stored in the 
Document Server or reduce 
the size of files to be printed.

DToner is almost empty. The toner has almost run out. Replace the toner cartridge 
with a new one.

Turn the main power switch 
off, then check the card.

The IEEE 802.11b interface 
unit may have come off, or an 
error may have occurred in the 
IEEE 802.11b interface unit.

Turn off the main power 
switch, and check the IEEE 
802.11b interface unit is in-
stalled correctly. If the mes-
sage appears again, contact 
your sales or service repre-
sentative.

You do not have a privilege to 
use this function. This job has 
been cancelled.

Print job canceled due to user 
restrictions.

Check the User Code permis-
sion status.

USB has a problem. An error has occurred in the 
USB interface.

Turn off the main power 
switch, and back on again. If 
the message appears again, 
contact your sales or service 
representative.

You do not have a privilege to 
use this function. This job has 
been cancelled.

The login user name or pass-
word entered is incorrect.

The right to use the function 
has not been set.

Check your login user name 
and password.

Consult an administrator.

You do not have a privilege to 
use this function.

The right to use this function 
has not been set.

Consult an administrator.

IEEE 802.11b (Wireless LAN) 
has a problem.

IEEE 802.11b interface unit 
was not inserted when the ma-
chine was turned on, or it was 
pulled out after the machine 
turned on.

Turn off the machine and 
check the IEEE 802.11b inter-
face unit is inserted correctly. 
Then, turn the machine on 
again. If the message appears 
again, call your service center.

Z-fold error. The Z-fold function has been 
disabled.

Check the paper feed direc-
tion, paper orientation, and 
folding position.

Messages/Second messages Causes Solutions
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The Machine Does Not Print

Possible Cause Solutions

Is the power on? Check the cable is securely plugged into the power outlet and the 
machine. 

Turn on the main power switch.

Is the machine online? If not, press [ffff Online] on the display panel.

Does the printer function 
status indicator stay red?

If so, check the error message on the display panel and take re-
quired action.

Is there a warning status or 
error message on the dis-
play panel?

If so, check the error message or warning status on the display 
panel and take the required action.

Can you print a configura-
tion page?

If you cannot print a configuration page, there maybe a machine 
malfunction. Contact your sales or service representative.

See p.114 “Printing the configuration page” for printing a config-
uration page.

Is the interface cable con-
nected securely to the ma-
chine and computer?

Connect the interface cable securely. If it has a fastener, fasten that 
securely as well.

See p.10 “Connecting the Machine”.

Are you using the correct 
interface cable?

The type of interface cable you should use depends on the compu-
ter. Be sure to use the correct one. If the cable is damaged or worn, 
replace it.

See p.10 “Connecting the Machine”.

Was the interface cable 
connected after the ma-
chine was turned on?

Connect the interface cable before turning on the machine.

Is the signal status satisfac-
tory when using wireless 
LAN in infrastructure 
mode ?

To check signal status, press {{{{User Tools/Counter}}}} key on the dis-
play panel, and then press [System Settings] on the display panel. 
On the [Interface Settings] tab, select [IEEE 802.11b], and then press 
[Wireless LAN Signal]. If signal quality is poor, move the machine to 
a location where radio waves can pass or remove objects that 
might cause interference.

Note
❒ You can check signal status only when using wireless LAN in 

infrastructure mode.

When using wireless LAN, 
is the SSID correctly set?

Check using the machine's display panel that the SSID is correctly set.

See “Interface Settings/IEEE 802.11b (Option)”, General Settings 
Guide.

When using wireless LAN, 
is the access point correctly 
set?

Check access point settings when in infrastructure mode. Depending 
on the access point, client access may be limited by MAC address.

Also, check there are no problems in transmission between access 
point and wired clients, and between access point and wireless clients.

When using wireless LAN, 
is the LED on the wireless 
LAN card lit or blinking?

Confirm the orange LED is lit, and the green LED is lit or blinks 
during transmission.
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Is the wireless LAN being 
used in ad hoc mode?

Turn the main power off and back on. See “Turning On the Pow-
er”, General Settings Guide.

Otherwise, configure [Network] in [Interface Settings] in [System Set-
tings]. See “Setting Up the Machine on a Network”, Network Guide.

Did you change the option 
settings on the machine?

When using the RPCS printer driver on Windows 2000 and con-
necting with IEEE 1394, an error may occur if you change the op-
tion settings on the machine. In this case, follow the procedure 
below:

A Unplug the IEEE 1394 interface cables connected to the computer.

B Run the utility tool for the IEEE 1394 interface board, which is 
stored in the following path on the CD-ROM “Printer Drivers 
and Utilities”.
\UTILITY\1394\

Reference
For more information about using the utility tool for IEEE 
1394, see the README file in the same directory on the CD-
ROM.

C Restart the computer.

D Connect the computer to the machine using the IEEE 1394 in-
terface cables.

Is the weekly timer set? The printer may not be able to print because of the weekly timer 
setting. Check the setting. For details, see “User Tools (System Set-
tings)”, General Settings Guide.

Print cannot be performed 
from the printer driver.

The login user name, password, or driver encryption key entered 
is incorrect.

A high level of encryption was set using the Extended Security 
function.

• Check your login user name, password, and driver encryption 
key.

• For information about the Extended Security settings, consult 
an administrator.

Possible Cause Solutions
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Problem Solutions

Is the Data In indicator 
blinking or lit after starting 
the print job?

If not, data is not being sent to the machine.

❖❖❖❖ When the machine is connected to the computer using 
the interface cable
Check the machine port settings are correct. For parallel port 
connection, port LPT1 or LPT2 should be set.

• Windows 95/98/Me

A Click the [Start] button, point to [Settings], and then click 
[Printers].

B Click the icon of the machine. On the [File] menu, click 
[Properties].

C Click the [Details] tab.

D In the [Print to the following port:] list, confirm the correct 
port is selected.

• Windows 2000

A Click the [Start] button, point to [Settings], and then click 
[Printers].

B Click the icon of the machine. On the [File] menu, click 
[Properties].

C Click the [Ports] tab.

D In the [Print to the following port(s)] list, confirm the correct 
port is selected.

• Windows XP Professional, Windows Server 2003

A Click the [Start] button, and then click [Printers and Faxes].

B Click the icon of the machine. On the [File] menu, click 
[Properties].

C Click the [Ports] tab.

D In the [Print to the following port(s)] list, confirm the correct 
port is selected.

• Windows XP Home Edition

A Click the [Start] button, click [Control Panel], click [Print-
ers and Other Hardware], and then click [Printers and Faxes].

B Click the icon of the machine. On the [File] menu, click 
[Properties].

C Click the [Ports] tab.

D In the [Print to the following port(s)] list, confirm the correct 
port is selected.

• Windows NT 4.0

A Click the [Start] button, point to [Settings], and then click 
[Printers].

B Click the icon of the machine. On the [File] menu, click 
[Properties].

C Click the [Ports] tab.

D In the [Print to the following port(s)] list, confirm the correct 
port is selected.

❖❖❖❖ Network connection
Contact your network administrator.
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Other Printing Problems

Problem Causes and Solutions

The print on the 
entire page is fad-
ed.

If the [Toner Saving] check box is selected in the printer driver settings, the 
entire page will be faded when printed.

For the RPCS printer driver, [Toner saving] is located on the [Print Quality] 
tab. For the PostScript 3 printer driver, see PostScript 3 Supplement.

See the printer driver Help.

Print is smudges. Settings for thick paper have not been made when printing on thick paper 
in the bypass tray.

• PCL 6/5e and PostScript 3
Select [Thick] in the [Type:] list on the [Paper] tab.

• RPCS
Select [Thick] in the [Paper type:] list on the [Print Settings] tab.

When printing 
graphics, the out-
put and the screen 
are different.

If the printer driver is configured to use the graphics command, the graph-
ics command from the machine is used to print.

If you want to print accurately, set the printer driver to print without using 
the graphics command.

See the printer driver Help.

Page layout is not 
as expected.

Print areas differ depending on machine used. Information that fits on a 
single page on one machine may not fit on a single page of another ma-
chine.

Adjust the [Printable area:] setting in the [Printer Configuration...] dialog box 
on the [Print Settings] tab in the RPCS printer driver.

See the printer driver Help.

Duplex printing is 
malfunctioning.

• Duplex printing cannot be done with paper set in the bypass tray. 
When using duplex printing, make settings to use paper from a tray 
other than the bypass tray.

• Duplex printing cannot be done with thick paper, OHP transparencies, 
or labels specified as the paper type. Specify another paper type.

• Duplex printing cannot be done with a tray for which [1 Sided Copy] has 
been specified as Paper Type on the System Settings menu. Change the 
Paper Type setting for the tray to [2 Sided Copy] on the System Settings 
menu. See General Settings Guide.
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When using Win-
dows 95/98/Me
/2000/XP, Win-
dows Server 2003, 
or Windows NT 
4.0, either com-
bined printing or 
booklet print does 
not come out as 
expected.

Make sure the application's paper size and orientation settings match those 
of the printer driver.

If a different paper size and orientation are set, select the same size and ori-
entation.

When using Win-
dows 95/98/Me
/2000/XP, Win-
dows Server 2003, 
or Windows NT 
4.0, Auto Reduce
/Enlarge print 
does not come out 
as expected.

A print instruc-
tion was issued 
from the compu-
ter, but printing 
did not start.

User code management may have been set. Ask the administrator about 
valid user codes. To print, the user code must be entered from the printer 
driver.

The print job is not 
canceled even 
when the machine 
is switched to of-
fline status.

Even when the machine is offline, printing is performed when [Job Accept-
ance Priority] has been set in [Parallel Interface] in the [Interface Settings] in the 
System Settings menu. Change the setting of Signal Control to Printer pri-
ority.

See “User Tools (System Settings)”, General Settings Guide.

Photo images are 
coarse.

Some applications reduce print resolution.

Fine dot pattern 
does not print.

Make the following settings with the printer driver:

• Change the [Dithering:] setting on the [Image Adjustments] tab in the 
[Change User Settings...] dialog box on the [Print Quality] tab in the RPCS 
printer driver.

Note
❒ To enable [Change User Settings...], select the [User settings] check box.

See the printer driver Help.

Images are cut off, 
or excess is print-
ed.

You may be using paper smaller than the size selected in the application. 
Use the same size paper as that selected in the application. If you cannot 
load paper of the correct size, use the reduction function to reduce the im-
age, and then print.

See the printer driver Help.

Problem Causes and Solutions
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It takes a long 
time to complete a 
print job.

Photographs and other data intensive pages take a long time for the ma-
chine to process, so simply wait when printing such data.

Changing the following settings with the printer driver may help speed up 
printing:

❖❖❖❖ PCL 6/5e
Select the lowest value for [Resolution] on the [Print Quality] tab in the 
printer properties dialog box.

❖❖❖❖ PostScript 3
Set the lower value in [Resolution]. The location of this setting is given 
below. 
If your operating system is Windows, select [PostScript (optimize for speed)] 
in [PostScript Output Option]. [PostScript Output Option] is located as follows:

• Windows 95/98/Me
[Print Quality] tab in the printer properties dialog box.

• Windows 2000/XP, Windows 2003 Server
[Print Quality] in [Graphics] on [Advanced...] on [Paper Quality] tab in the 
printer properties dialog box.

• Windows NT 4.0
[Graphics] on [Advanced...] on [Paper Quality] tab in the printer proper-
ties dialog box.

• Mac OS 9.x
[Printer Specifications] in the print dialog box.

• Mac OS X
[Set 3] tab in [Printer Features] in the print dialog box.

If you use Windows, select [PostScript (optimize for speed)]

• Windows 95/98/Me
[PostScript output format:] on the [PostScript] tab in the printer proper-
ties dialog box.

• Windows 2000/XP, Windows Server 2003
[PostScript Output Option] in [PostScript Option] on [Advanced...] on 
[Print Quality] tab in the printer properties dialog box.

• Windows NT 4.0
[PostScript Output Option] in [PostScript Option] on [Document Options] 
on [Advanced...] tab in the printer properties dialog box.

❖❖❖❖ RPCS
Select the lowest value for [Resolution:] on the [Image Adjustments] tab in 
the [Change User Settings...] dialog box on the [Print Quality] tab in the 
printer properties dialog box.
Select [Speed] for [Print priority] on the [Print Quality] tab in the printer 
driver's dialog box.

Note
❒ To enable [Change User Settings...], select the [User settings] check box.
Select [Fast] for [Document type] list on the [Print Quality] tab in the printer 
properties dialog box.

See the printer driver Help.

Problem Causes and Solutions
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It takes a long 
time to complete a 
print job.

The data is so large or complex that it takes time to process. If the Data In 
indicator is blinking, data is being processed. Simply wait until printing 
resumes.

If “Warming Up...” appears on the display panel, the machine is warming 
up. Wait for a while.

It takes too much 
time to resume 
printing.

The data is so large or complex that it takes time to process. If the Data In 
indicator is blinking, data is being processed. Simply wait until printing 
resumes.

The machine was in Energy Saver mode. To resume from Energy Saver 
mode, it has to warm up, and this takes time. To disable Energy Saver 
mode, select [Off] for Energy Saver 1 in the System Settings menu. See Gen-
eral Settings Guide.

Paper is not fed 
from the selected 
tray.

When you are using a Windows operating system, printer driver settings 
override those set using the display panel. Set the desired input tray using 
the printer driver.

See the printer driver Help.

Solid lines are 
printed as broken 
lines.

Make the following settings with the printer driver:

• Change the [Dithering:] setting on the [Image Adjustments] tab in the 
[Change User Settings...] dialog box, on the [Print Quality] tab in the RPCS 
printer driver.

See the printer driver Help.

Optional compo-
nents connected to 
the machine are 
not recognized 
when using Win-
dows 95/98/Me, 
Windows 2000
/XP, Windows 
Server 2003, and 
Windows NT 4.0.

You have to configure the option setup in printer properties when bidirec-
tional transmission is not enabled.

See the printer driver Help.

Images are print-
ed in the wrong 
orientation.

The feed orientation you selected and the feed orientation selected in the 
printer driver's option setup might not be the same. Set the machine's feed 
orientation and the printer driver's feed orientation accordingly.

See the printer driver Help.

The printed image 
is different from 
the image on the 
computer's dis-
play.

With certain functions, such as enlargement and reduction, image layout 
might be different to that on the computer display.

You might have selected to replace True Type fonts with machine fonts in 
the printing process.

To print an image similar to that of the computer display, make settings to 
print True Type fonts as an image.

See the printer driver Help.

Problem Causes and Solutions
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Note
❒ If the problem cannot be solved, contact your sales or service representative.

No transmission 
when using 1394 
interface connec-
tion

Check using the following procedure:

A Confirm the IEEE 1394 interface cable is connected securely.

B Restart the computer.
If the error occurs even after executing the above operation, proceed to 
the following steps.

C Unplug the IEEE 1394 interface cable connected to the computer.

D Run the utility tool for the IEEE 1394 interface board, which is stored in 
the following path on the CD-ROM “Printer Drivers and Utilities”:
\UTILITY\1394\

Reference
For more information about using the utility tool for IEEE 1394, see 
the README file in the same directory on the CD-ROM.

E Restart the computer.

When connecting 
the machine using 
USB 2.0, the first 
page of a print job 
that contains a 
large volume of 
data is printed, 
but the remaining 
pages are not.

Check that USB Printing Support is installed on your computer.

Reference
See p.43 “Installing the Printer Driver Using USB”.

Problem Causes and Solutions
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System Settings (Parallel Connection)

Interface Settings/Parallel Interface

❖❖❖❖ Parallel Timing
Specifies the timing for the parallel
interface. Normally, you do not
need to change this setting.
• ACK Inside
• ACK Outside
• STB Down

Note
❒ Default: ACK Inside

❖❖❖❖ Parallel Communication Speed
Specifies the communication
speed of the parallel interface. If
the speed is too high, data may not
be transferred smoothly. If this
happens, change the setting to
“Standard”.
• High Speed
• Standard

Note
❒ Default: High Speed

❖❖❖❖ Selection Signal Status
Specifies the signal level of the par-
allel interface.
• High
• Low

Note
❒ Default: High

❖❖❖❖ Input Prime
Specifies whether the prime signal
is active or inactive when an input
prime signal is sent. Normally, you
do not need to change this setting.
• Effective
• Invalid

Note
❒ Default: Invalid

❖❖❖❖ Bidirectional Communication
Specifies, for instance, how a print-
er connected to the parallel inter-
face responds to a status request. If
you experience problems using an-
other manufacturer’s printer, set
this to Off.

Limitation
❒ If set to Off, asynchronous com-

munication will not work.
• On
• Off

Note
❒ Default: On

❖❖❖❖ Signal Control
Specifies how to handle any errors
that occur when printing from a
computer. Normally, you do not
need to change this setting.
• Job Acceptance Priority
• Printer Priority

Note
❒ Default: Job Acceptance Priority
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Precautions when using Windows Server 
2003

Precautions when using the Terminal Server mode

Certain printer driver functions are disabled. Disabled functions are displayed
in gray. When using all printer driver functions, use Windows Server 2003 in
normal mode.
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Specifications

This section contains the machine's electrical and hardware specifications, in-
cluding information about its options.

Component Specifications 

Resolution PCL 5e : 300 dpi, 600 dpi

PCL 6 : 600 dpi, 1200 dpi

RPCS : 300 dpi, 600 dpi, 1200 dpi

PostScript 3 : 600 dpi, 1200 dpi

Printing speed 51 ppm / 60 ppm / 75 ppm

(A4K, 8/" × 11"K plain paper)

Note
❒ Printing speeds depend on the machine. Check which type of 

machine you have. See General Settings Guide.

Interface Standard:

• IEEE 1284 parallel interface

Note
❒ Use a standard 36-pin printer cable not longer than 3 meters 

(10 feet).

• Ethernet interface (100BASE-TX / 10BASE-T)

Option:

• IEEE 1394 interface

• IEEE 802.11b wireless LAN interface

• USB 2.0 interface

• Bluetooth™ interface

Network protocol TCP/IP, IPX/SPX, NetBEUI *1 , AppleTalk

Printer language Standard: PCL 6/5e, RPCS

Option: PostScript 3, PDF

Fonts PCL 6/5e :

Agfa Monotype 35 Intellifonts, 10 TrueType fonts, and 1 Bitmap font.

PostScript 3 :

136 fonts (Type 2:24, Type 14:112)

Memory 384 MB

Hard disk Storage capacity : 40 GB

Operating systems sup-
ported by this machine

Windows 95/98/Me

Windows 2000

Windows XP

Windows Server 2003

Windows NT 4.0

Mac OS 8.6 to 9.2

Mac OS X
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*1 To use NetBEUI, use the SmartDeviceMonitor port.

Options

Limitation
❒ Only one optional interface board can be installed in the machine at a time.

Therefore, the optional IEEE 1394 interface board, the IEEE 802.11b interface
unit, the USB 2.0 interface board, and Bluetooth interface unit cannot be in-
stalled concurrently.

IEEE 1394 Interface Board Type B

❖❖❖❖ Transmission spec.:
IEEE 1394

❖❖❖❖ Interface:
IEEE std 1394-1995 compliant
IEEE std 1394a-2000 compliant

❖❖❖❖ Device class:
SCSI print (Windows 2000/XP, Windows Server 2003)
IP over 1394 (Windows Me/XP, Windows Server 2003)

❖❖❖❖ Protocol:
SBP-2 (SCSI print)
TCP/IP (IP over 1394)

❖❖❖❖ Interface connector:
IEEE 1394 (6 pin × 2)

❖❖❖❖ Required cable:
1394 interface cable (6 pin x 4 pin, 6 pin x 6 pin)

Important
❒ You cannot plug devices together to create loops.
❒ Do not use cable that is more than 4.5 meters in length.

❖❖❖❖ Data transfer speed:
Maximum 400 Mbps

❖❖❖❖ Connectable number of devices on a bus:
Maximum 63

❖❖❖❖ Allowed cable hops on a bus:
Maximum 16

Network cable 100BASE-TX / 10BASE-T shielded twisted-pair (STP, Category
/Type5) cable.

Component Specifications 
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❖❖❖❖ Power supply:
Non external power supply
Cable Power repeated (IEEE 1394a-2000 compliant)

IEEE 802.11b Interface Unit Type H

❖❖❖❖ Transmission Spec.:
Based on IEEE 802.11b (Wireless LAN)

❖❖❖❖ Protocol:
TCP/IP, NetBEUI, IPX/SPX, AppleTalk

Note
❒ SmartDeviceMonitor and Web Image Monitor are supported.

❖❖❖❖ Data Transfer Speed:
Auto select from below speed
1 Mbps, 2 Mbps, 5.5 Mbps, 11 Mbps

❖❖❖❖ Frequency Range:
• Inch version:

2412-2462 MHz (1-11 channels)
• Metric version:

2412-2472 MHz (1-13 channels)

❖❖❖❖ Transmittable Distance:
1 Mbps 400 m *1 

2 Mbps 270 m *1 

5.5 Mbps 200 m *1 

11 Mbps 140 m *1 

*1 These figures are a guideline for outdoor use. In general, the transmittable dis-
tance indoors is 10-100 m, depending on the environment.

❖❖❖❖ Transmission Mode:
ad hoc mode and infrastructure mode

USB2.0 Interface Board Type B

❖❖❖❖ Transmission spec:
Based on USB 2.0

❖❖❖❖ Data transfer speed:
High Speed: 480 Mbps
Full Speed: 12 Mbps

❖❖❖❖ Supported operating system:
Windows 98 SE/Me/2000/XP, Windows Server 2003, Mac OS 9.x, Mac OS X
Classic
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Note
❒ This USB 2.0 interface board is compatible with devices that support USB

1.1.
❒ For Windows 98 SE/Me, be sure to install USB Printing Support included

on the CD-ROM that comes with this machine. When USB 2.0 is used un-
der Windows 98 SE/Me, only a speed equal to that of USB 1.1 is possible.

❒ Mac OS supports only the standard USB 1.1 port.

PostScript 3 Unit Type 2075

Reference
See PostScript 3 Supplement.

Bluetooth Interface Unit Type 2238

Reference
See p.55 “Printing with Bluetooth™ Connection”.
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Bluetooth Interface Unit Type 2238,   154
Bypass tray,   14

C

Canceling a job
Windows,   110

Chaptering,   104
Clear/Stop key,   6
Collate,   88
Configuration page,   114
Connection

Ethernet board connection,   10
IEEE 1394 interface board 

connection,   10
Parallel interface connection,   10
USB connection,   10

Control Panel,   5
Control panel

locked print,   85
printer features, adjusting,   111
sample print,   82

Covers,   98
Custom size paper,   16

printing, bypass tray,   14

D

Data In indicator,   143, 147
Display panel,   5, 6

error messages,   137
Document Server,   123

E

Energy Saver key,   5
Error messages,   137

F

Finisher,   90
Font Manager 2000,   62
Fonts,   151
Function keys,   6
Function status indicator,   6

H

Hard disk,   151
Host Interface,   120

I

IEEE 1394 Interface Board Type B,   152
IEEE 802.11b Interface Unit Type H,   153
Installing the Printer Driver

Quick Install,   19
Installing the Printer Driver Using USB

Windows 2000,   43
Interface,   151

J

Job List,   5

L

List / Test Print,   114
Locked print,   85

deleting,   86

M

Main power indicator,   5
Maintenance,   116
Memory,   151

N

Network Cable,   152
Network protocol,   151
Number keys,   6

O

OHP Transparencies
printing, bypass tray,   17

On indicator,   5
Operating system,   151
Operation switch,   6
Options,   152
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P

PageMaker,   63
PCL menu,   120
PDF Direct Print,   81
PostScript 3 Unit Type 2075,   154
Precautions when using

 the Terminal Server mode
Windows Server 2003,   150

Precautions when using 
Windows Server 2003

Windows Server 2003,   150
printer driver,   132
Printer features

adjusting,   113
menu,   111
parameters,   114

Printer Language,   151
Printing a PDF File Directly

PDF Direct Print,   81
Printing Method

PDF Direct Print,   81
Printing speed,   151
Printing with Bluetooth Connection

Windows,   55
Printing with Parallel Connection

Windows 2000,   49
Punch,   93

R

Resolution,   151

S

Sample print,   82
deleting,   84

Slip Sheets,   102
SmartDeviceMonitor for Admin,   134
SmartDeviceMonitor for Client,   135
Specifications,   151
Spool printing,   97
Staple,   91
System,   116

T

Tab Sheet,   106
Thick Paper

printing, bypass tray,   17
Troubleshooting,   137

error messages,   137
machine does not print,   141
other printing problems,   144
status messages,   137

U

USB2.0 Interface Board Type B,   153
User Tools/Counter/Inquiry,   5

W

Windows
canceling a job,   110

Windows 2000
printer properties, PCL,   67
printer properties, RPCS,   75

Windows 95/98/Me
printer properties, PCL,   65
printer properties, RPCS,   73

Windows NT 4.0
document defaults, PCL,   71
document defaults, RPCS,   79
printer properties, PCL,   71
printer properties, RPCS,   79

Windows Server 2003
printer properties, PCL,   69
printer properties, RPCS,   77

Windows XP
printer properties, PCL,   69
printer properties, RPCS,   77
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Note to users in the United States of America

Notice:
This equipment has been tested and found to comply with the limits for a Class B digital device, pursu-
ant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference in a residential installation. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equip-
ment does cause harmful interference to radio or television reception, which can be determined by turn-
ing the equipment off and on, the user is encouraged to try to correct the interference by one more of
the following measures:

Reorient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.
Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.
Consult the dealer or an experienced radio/TV technician for help.

Caution
Changes or modifications not expressly approved by the party responsible for compliance could void
the user's authority to operate the equipment.

Caution (in case of IEEE1284 environment) :
Properly shielded and grounded cables and connectors must be used for connections to host computer
(and/or peripheral) in order to meet FCC emission limits.
Use a commercially available shielded cable.

Caution (in case of 100BaseTX environment):
Network interface cable with ferrite core must be used for RF interference suppression.
Use a commercially available cable after attaching the ferrite core provided.

Caution (in case of IEEE1394 environment):
Use the cable provided with the machine.

Caution (in case of USB2.0 environment):
Use a commercially available shielded USB cable.

Declaration of Conformity
Product Name:
Printer/Scanner Controller
Printer/Scanner Controller + Copy Machine
Model Number: 
Printer/Scanner Unit Type 2075 (Printer/Scanner Controller)
4051SP/DSm651SP/LD151SP/Aficio2051SP (Printer/Scanner Controller + Copy Machine)
4060SP/DSm660SP/LD160SP/Aficio2060SP (Printer/Scanner Controller + Copy Machine)
4075SP/DSm675SP/LD175SP/Aficio2075SP (Printer/Scanner Controller + Copy Machine)
Responsible party: Ricoh Corporation
Address: 5 Dedrick Place, West Caldwell, NJ 07006
Telephone number: 973-882-2000
This device complies with part 15 of FCC Rules.
Operation is subject to the following two conditions:
1. This device may not cause harmful interference, and
2. this device must accept any interference received,
including interference that may cause undesired operation.

Note to users in Canada

Note:
This Class B digital apparatus complies with Canadian ICES-003.

Remarque concernant les utilisateurs au Canada

Avertissement:
Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.

Introduction

This manual contains detailed instructions and notes on the operation and use of this machine. For your
safety and benefit, read this manual carefully before using the machine. Keep this manual in a handy
place for quick reference.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be li-
able for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.

Warning

Use of controls or adjustment or performance of procedures other than those specified in this manual
might result in hazardous radiation exposure.

Two kinds of size notation are employed in this manual. With this machine refer to the inch version.

Trademarks

Microsoft®, Windows® and Windows NT® are registered trademarks of Microsoft Corporation in the
United States and/or other countries.

Adobe®, PostScript®, Acrobat®, PageMaker® and Adobe Type Manager are registered trademarks of
Adobe Systems Incorporated.

PCL® is a registered trademark of Hewlett-Packard Company.

AppleTalk, Apple, Macintosh and Mac are registered trademarks of Apple Computer, Incorporated.

IPS-PRINT™ Printer Language Emulation Copyright© 2000, Oak Technology, Inc., All Rights Re-
served.

UNIX is a registered trademark in the United States and other countries, licensed exclusively through
X/Open Company Limited.

Bluetooth is a Trademark of the Bluetooth SIG, Inc. (Special Interest Group) and licensed to RICOH
company limited.

Copyright © 2001 Bluetooth SIG, Inc.

The Bluetooth Trademarks are owned by Bluetooth SIG, Inc. USA

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights to those marks.

The proper names of the Windows operating systems are as follows:

• The product name of Windows® 95 is Microsoft® Windows® 95

• The product name of Windows® 98 is Microsoft® Windows® 98

• The product name of Windows® Me is Microsoft® Windows®  Millennium Edition (Windows Me)

• The product name of Windows® 2000 are as follows:
Microsoft® Windows® 2000 Professional
Microsoft® Windows® 2000 Server
Microsoft® Windows® 2000 Advanced Server

• The product name of Windows® XP are as follows:
Microsoft® Windows® XP Home Edition
Microsoft® Windows® XP Professional

• The product names of Windows Server™ 2003 are as follows:
Microsoft® Windows Server™ 2003 Standard Edition
Microsoft® Windows Server™ 2003 Enterprise Edition

• The product name of Windows NT® 4.0 are as follows:
Microsoft® Windows NT® Workstation 4.0
Microsoft® Windows NT® Server 4.0

Notes

Some illustrations in this manual might be slightly different from the machine.

Certain options might not be available in some countries. For details, please contact your local dealer. Copyright © 2004
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Operating Instructions

Printer Reference

Read this manual carefully before you use this machine and keep it handy for future reference. For safe and correct use, be sure to read the Safety
Information in the "General Settings Guide" before using the machine.

Getting Started

Preparing the Machine

Setting Up the Printer Driver

Other Print Operations

Printer Features

Using the Document Server

The Functions and Settings of the Machine

Appendix

Printed in Japan

EN USA B659-8607B


